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1. Цель и задачи освоения дисциплины 

Цельюизучения дисциплины является формирование набора общепрофессиональных и 

профессиональных компетенций будущего бакалавра по направлению 09.03.02 Информационные 

системы и технологии.  

Задачи освоения дисциплины: 

 формирование у студентов знаний об основных принципах алгоритмизации и 

программирования; 

 формирование практических навыков создания прикладных программных продуктов 

на основе современных технологий программирования с использованием одного из 

наиболее распространенных алгоритмических языков – языка С++. 

 

2. Перечень планируемых результатов обучения по дисциплине (модулю) 

соотнесенных с планируемыми результатами освоения образовательной 

программы 

2.1. Наименование компетенций 

Код 

 

Формулировка:  

ОПК-1 владением широкой общей подготовкой (базовыми знаниями) для решения 

практических задач в области информационных технологий 

ОПК-6 способностью выбирать и оценивать способ реализации информационных 

систем и устройств (программно-, аппаратно- или программно-аппаратно-) 

для решения поставленной задачи 

ПК-22 способностью  проводить  сбор,  анализ  научно-технической  информации,  

отечественного  и зарубежного опыта по тематике исследования 

3. Наименование лабораторных работ 

№ 

темы 

Наименование тем дисциплины, их краткое 

содержание 

Обьем 

часов 

Интерактивая 

форма проведения  

 6 семестр   

4 Лабораторная работа 1. Форматирование данных в 

Microsoft Excel 

3  

5 Лабораторная работа 2. Технология консолидации 

табличных данных. Сводные таблицы 

3  

6 Лабораторная работа 3. "Работа со шрифтом. 

Текстовые эффекты". часть 1 

3  

7 Лабораторная работа 4. "Работа со шрифтом. 

Текстовые эффекты". часть 2 

3  

7 Лабораторная работа 5. "Создание различных 

эффектов Photoshop " 

3  

8 лабораторная работа 6. Знакомство с Flash-

технологией 

3  

8 Лабораторная работа 7. Работа со звуком во Flash 3  

9 Лабораторная работа 8. Базовые навыки работы в 

Deductor Studio 5.1 

3  

9 Лабораторная работа 9. Базовые визуализаторы 3  

 Итого за 6 семестр 27  

 Итого  27  

 



ЛАБОРАТОРНАЯ РАБОТА 1. ФОРМАТИРОВАНИЕ ДАННЫХ В 

MICROSOFT EXCEL 

 

Цель и задачи работы: научиться технологиям условного форматирования 

данных и организации ветвлений средствами MS Excel. 

 

Теоретическое обоснование 

1. Условное форматирование. Так как программаExcelпредназначенадля 

обработки чисел, важную роль играет правильная настройка их формата. 
Варианты формата данных можно выбрать с помощью команды Формат ► 

Ячейки. На вкладке Число имеется множество готовых числовых форматов, 

которые мы, ввиду их очевидности, рассматривать не будем. 

Познакомимся со средствами создания собственных форматов. Для этого 

в разделе Числовые форматы выберите пункт (все форматы). Теперь в окошко 

Тип можно ввести собственный шаблон, который и определит вид данных. 
Для образования пользовательских форматов применяются специальные 

символы шаблона, которые указывают, что именно будет предъявлено на их месте 

в клетке таблицы. Кроме этих символов внутри шаблона можно вставлять любые 

собственные символы, слова. Не допускается использовать только знаки 
 

!^&’`~{}=<>. Если все-таки возникает необходимость вставить их в шаблон, 

следует заключать их в двойные кавычки. 

Так, если в поле Тип ввести, например, формат, 

то в текущей клетке числовые данные будут отображаться символами 

красного цвета обязательно с тремя целыми и двумя дробными разрядами 

(независимо от фактического наличия этих значений в данных) и с текстом км/час. 

Для форматирования чисел используются следующие символы шаблона: 

 
  



4 

 

0 Отображает  цифру  числа,  в  том числе и если это ведущие и 

концевые нули 

# Действует аналогично, но не показывает ведущие и концевые 

нули 

? Действует аналогично, но ведущие и  концевые  нули  

замещаются  на пробелы. Это позволяет выравнивать числа в 

столбце, несмотря на отсутствие/наличие нулей 

, Десятичная запятая 

Е-, е-, Е+, 

е+ 

Экспоненциальный формат. При выборе E+ (или e+) перед 

отрицательными  показателями  степени отображается знак 

минус, а перед положительными  —  плюс.  Если используется  

формат  E-  (или  e-) знак  минус отображается перед  

отрицательными показателями степени, а знак плюс перед 

положительными показателями не отображается 

“ ” Используется для включения  в формат любых символов, сами 

кавычки при этом не выводятся 

/ Шаблон  дроби.  Выводит  нецелое число в виде обыкновенной 

дроби с числителем и знаменателем 

% Шаблон процента. Введенное число умножается на 100 и 

выводится со знаком процента 

 
 

_ Знак подчеркивания. Используется для выравнивания данных. 

Вставляет пробел, равный ширине следующего символа, 

например, пара знаков_) вставляет в формат пробел, равный 

ширине скобки 

; Содержимое ячейки не отображается на экране 

* Символ  повтора (устанавливается перед  числовым  

шаблоном).  Следующий за звездочкой знак будет 

предшествовать самому числу столько раз, сколько нужно, 

чтобы заполнить  всю  клетку.  Используется  для  заполнения  

возможных пробелов перед числом, чтобы избежать  

возможной  подделки  (дописывания цифр слева). 

Пробел (внутри 

шаблона) 

Устанавливает  разделитель тысяч в целой части числа 

Пробел (в  конце 

шаблона) 

Масштабирует число, округляя его до тысяч 

 
 



Примеры форматов и видимые результаты их применения к

 числу8123,46 представлены в таблице 1.1. 

Условное форматирование позволяет реализовать разный вид информации, 

находящейся в ячейке, в зависимости от значения данных в ней. Структура такого 

пользовательского числового формата зависит от значения вводимого числа и 

может содержать до четырех секций, разделенных точкой с запятой: 

Положительное; Отрицательное; Нулевое; Текстовое 

Таблица 1.1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Если формат содержит только одну часть, она используется для вывода всех 

чисел. Если две, то первая применяется для вывода положительных и ну-левых 

значений, вторая – для вывода отрицательных. Если три, то для положи-тельных, 

нулевых и отрицательных соответственно. Текстовый формат всегда должен быть 

четвертым по счету. Если каких-то промежуточных форматов нет, вместо них 

вводится точка с запятой. 

Предположим, что нужно, чтобы: 

 положительные значения выводились со словом Приход,

 отрицательные значения выводились красным цветом со словом 

Расход,

 нулевые – отображались словом Ничего синего цвета,

 символьные – словом Ошибка.

Желаемый формат будет таким: 

Вопросительные знаки введены, чтобы размер поля под собственно число 

был всегда одним и тем же, несмотря на отсутствие ведущих нулей. Таким образом, 

слова Приход и Расход всегда будут расположены в одном и том же месте. 

Результаты применения формата при вводе различных данных изображены на рис. 

1.1. 
 
 
 
 

Рисунок 1.1  Результаты применения формата 

 



В формате можно использовать следующие цвета: Черный, Синий, Голубой, 

Зеленый, Розовый, Красный, Белый, Желтый. Можно вообще указать толь-ко 

цвета, например, 
 
 

Если условия не заданы, то, как было сказано выше, они подразумевают-ся 

перечисленными в последовательности: >0,<0, =0. Иные условия, управля-ющие 

форматированием, могут быть явно определены пользователем в самом формате. 

Пример. Пусть требуется отображать денежные данные в следующем виде: 

 если сумма менее тысячи рублей – результат выводится с буквой «р» 

(например, число 34 будет отображено как 34 р),

 если сумма менее миллиона рублей – с буквами «тыс.р», 

округленной до тысяч с одним дробным разрядом (например, число 

34567 будет отображено как 34,6 тыс.р),

 в противном случае (т.е. если сумма не менее миллиона) - с буквами 

«млн.р», округленной до миллионов с одним дробным разрядом(число 

3456789 будет отображено как 3,5 млн.р). Указанный результат может быть 

получен с помощью формата
 
 
 
 
 
 

Масштабирование до тысяч и миллионов осуществляется с помощью 

форматирующих пробелов (одного и двух соответственно). 

2. Мастер условного форматирования. ВExcelимеются 

средстваусловного форматирования, дающие возможность управлять цветом и 

текста и заливки, видом рамки, шрифта, подчеркиванием. Само условие может 

быть сложным и зависеть от значения не только текущей, но и любой другой 

(других) ячеек. Интерфейс такого форматирования доступен через меню Формат 

► Условное форматирование (рис.1.2). 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.2  Диалоговое окно интерфейса условного форматирования 

Условий может быть установлено до трех. Само условие может быть двух 

видов: 

1. Позволяет задать значения (значения), относительно которого 

проверяется форматируемая ячейка. 
2. Позволяет указать логическую формулу любой сложности (слово 

значение заменяется на слово формула). 



Пусть например, требуется выделить дату, содержащуюся в D12, 

соответствующую выходному дню. Воспользуемся функцией ДЕНЬНЕД, которая 

возвращает день недели как целое в интервале от 1 (понедельник) до 7 

(воскресенье). Введем в окно Мастера следующее выражение (рис.1.3): 

 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.3  Ввод условия 

3. Контроль ввода. При работе с данными во многих случаях 

важнымявляется правильность их ввода. Например, далеко не все равно, введете 

ли вы название некоторой организации в форме «АО Туризм» или «Туризм АО» 

или просто «Туризм». Если предполагается последующая сортировка, 

группировка или другое обобщение данных, эти слова система сочтет именами 

разных организаций и подведет по ним три разных итога. 
В Excel имеются средства контроля ввода данных, которые можно закрепить 

за определенными ячейками таблицы. Они доступны через меню Данные 

► Проверка, открывающее окно Проверка вводимых значений, состоящее из 

трех вкладок (рис. 1.4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.4  Диалоговое окно проверки вводимых значений 

Вкладка Параметры определяет условия, проверяемые системой при вводе. 

Во вкладке Сообщение для ввода формируется подсказка при входе в 

контролируемую клетку. Во вкладке Сообщение об ошибке формируется 

сообщение, предъявляемое пользователю, если он ввел неправильное значение. 



Важнейшей является вкладка Параметры, к которой задается тип 

контролируемой величины. Предположим, в некоторую ячейку нужно ввести дату 

рождения работника предприятия. Ясно, что он не может быть моложе 16 лет и 

старше 80-ти. Вкладка Параметры, заполненная для этого случая, как раз и 

изображена на рис. 1.4. Установка флага Игнорировать пустые ячейки подавля-ет 

вывод сообщения об ошибке при вводе пустого значения в контролируемую ячейку 

рабочего листа. 
 
 
 
 

Рисунок 1.5  Вид подсказки 

Пусть мы хотим, чтобы при входе в клетку предъявлялась подсказка, 

изображенная на рис. 1.5. Эта цель может быть достигнута следующим 

заполнением вкладки Сообщение об ошибке (рис. 1.6). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.6  Диалоговое окно проверки вводимых значений 

Вкладка Сообщение об ошибке (рис. 1.7) предопределяет реакцию систе-мы 

на ошибочный ввод. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.7  Вкладка «Сообщение об ошибках» диалогового окна 

Сообщение об ошибке может быть трех видов: 

 Останов. Запрещает ввод неправильных данных.



 Предупреждение. Пользователь может игнорировать 

предупреждение системы и оставить введенное значение, вернуться 

для исправления ввода или совсем отказаться от него.

 Сообщение. Пользователь может оставить введенные данные 

илиотказаться от них.

Выберите реакцию Останов, которая при неверном вводе выдаст сообщение, 

изображенное на рис. 1.8. 
 
 
 
 
 
 
 
 

Рисунок 1.8  Вид сообщения об ошибке ввода 

Замечание.Ускорить процесс оформления таблицы можно 

воспользовавшись средствами копирования форматов, которые доступны через 

пиктограмму Формат по образцу  

 

4. Организация ветвлений. При решении некоторых задач вMS Excel 
значение ячейки необходимо вычислить одним из нескольких способов, в 

зависимости от выполнения или невыполнения одного или нескольких условий. 

Схематично это можно представить следующим образом: 

 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.9  Блок-схема разветвляющегося алгоритма 

Конструкция, в которой в зависимости от условия осуществляется то или 

иное действие, называется ветвлением. 

Условие представляет собой величины и/или выражения одного типа, 

связанные между собой одним из знаков отношений: > (больше); < (меньше); >= 

(больше или равно); <= (меньше или равно); = (равно); <> (не равно). 

Условие принимает одно из двух возможных значений истина или ложь. 

Условия бывают: 

 простые;

 сложные (составные).

Простое условие соединяет между собой величины или выражения только 

одним из знаков отношений. 



Сложным (составным)условием называется несколько простых 

условий,связанных между собой с помощью логических операций И (логическое 

умножение), ИЛИ (логическое сложение). 

Методика и порядок выполнения работы 

Упражнение 1 

Для реализации ветвлений в Excel используется логическая функция ЕСЛИ. 

Формат записи: 

= ЕСЛИ (условие; действие1;действие2). 
Эта запись означает: 

1. если условие выполняется, то выполняется действие1; 
2. в противном случае, т.е. если не выполняется условие, то 

выполняется действие2. 
Функция ЕСЛИ используется для выполнения действий (принятия решения) 

в зависимости от условия. 

В качестве действия1 или действия2 могут быть: 
 числовое выражение;

 функция или формула;

 ссылка на ячейку таблицы;

 заключенный в кавычки (“ “) текст.

Задача 1. В ячейкуВ1следует записать число1,если положительно 

произведение ячеек А1 и А2, в противном случае записать в ячейку В1 число 0. 

Решение: Для выполнения этого задания в ячейкуВ1следует записать 

формулу: =ЕСЛИ(А1*А2>0; 1;0) 

Задача 2. Пусть ряду работников начислена заработная 

плата,котораяотображена в столбце В (рис. 1.10). В столбце С необходимо 

рассчитать подоходный налог с каждого работника, по следующей схеме: если 

размер заработной платы менее 2000 руб., то с работника налог взимается в размере 

10% от заработной платы, в противном случае 12%. В столбце D получить суммы, 

которые получит каждый работник в итоге. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.10 – Примерный вид таблицы 

Решение: 

1. в ячейку С2 следует ввести формулу: 

=ЕСЛИ(В2<2000;B2*10%;B2*12%) 



2. скопировать эту формулу в ячейки диапазона С3:С6. В результате в 

столбце С будет получена сумма налога, удержанная с каждого 

работника; 
3. в ячейку D2 ввести формулу для подсчета итоговой суммы: =B2-C2 
4. скопировать эту формулу в ячейки D3:D6. В результате таблица 

примет следующий вид, изображенный на рис. 1.11. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.11 – Таблица для расчета заработной платы работникам 

Упражнение 2. Формирование ветвлений со сложными условиями 

Для формирования сложных условий используются следующие логиче-ские 

функции: 

 И (AND);

 ИЛИ (OR).

Формат записи функции И: И(условие1;условие2,…) 

Данная функция используется в случаях, когда простые условия соедине-ны 

между собой союзом «И». 

Например, условие «число в ячейке А1 – положительное и больше 100» 

можно записать следующим образом: 

И(А1>0;A1>100) 

Функция И возвращает значение ИСТИНА, если все ее аргументы имеют 

значение ИСТИНА; значение ЛОЖЬ, если хотя бы один аргумент имеет значение 

ЛОЖЬ. Функция И может содержать от 1 до 30 проверяемых условий. 

Например, 

1. функция =И(2+2=4; 2+3=5) примет значение ИСТИНА, т.к. оба 

простых условия истины; 
2. если ячейка B4 =160, то функция =И(B4>1; B4<100) возвратит 

значение ЛОЖЬ, т.к. одно из условий принимает значение ЛОЖЬ. 
Задача 3. Предположим,что ячейкаС2принимает значение ячейкиB4,если В4 

содержит число строго между 1 и 100, в противном случае в ячейке С2 вывести 

сообщение "Значение вне интервала". 

Решение:Для реализации поставленной задачи в ячейкуС2следует записать 

следующую формулу: 

=ЕСЛИ(И(1<B4; B4<100); B4; "Значение вне интервала") 

Формат записи функции ИЛИ: ИЛИ(условие1; условие2,…) 

Функция ИЛИ используется в случаях, когда простые условия соединены 

между собой союзом «ИЛИ». 



Например, условие «число в ячейке А1 меньше -5 или больше 10» можно 

записать следующим образом: ИЛИ(А1<-5;A1>10) 

Данная функция возвращает ИСТИНА, если хотя бы один из аргументов 

имеет значение ИСТИНА; возвращает ЛОЖЬ, если все аргументы имеют значение 

ЛОЖЬ. Функция ИЛИ также может содержать от 1 до 30 проверяемых условий. 
Например, ИЛИ(1+1=1;2+2=5) равняется ЛОЖЬ. Упражнение 3. Формирование 

вложенных ветвлений 

Существует такой класс задач, когда при проверке одного условия, в случае, 

если это условие не выполняется, проверяется еще одно условие. Схематично это 

можно представить следующим образом: 

 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 1.12  Блок-схема вложенного разветвляющегося алгоритмов 

Для решения таких задач применяют вложенные логические функции ЕСЛИ. 

Формат записи: = ЕСЛИ(условие1;действие1;ЕСЛИ(условие2;дей-ствие2; 

ЕСЛИ (…))) 

 

Эта запись означает: 

1. если условие1 выполняется, то выполняется действие1; 
2. если условие1 не выполняется, то используется еще одна вложенная 

функция ЕСЛИ, в которой проверяется другое условие2, и т.д. 

До 7 функций ЕСЛИ могут быть вложены друг в друга в качестве значений 

аргументов действие1 и действие2. Кроме того, необходимо помнить, что число 

открывающих и закрывающих скобок в таком выражении должно быть одинаково. 

Задача 4. Пусть ряду работников начислена заработная 

плата,котораяотображена в столбце В (рис. 1.13). В столбце С необходимо 

рассчитать подоходный налог с каждого работника, по следующей схеме: если 

размер заработной платы работника менее 2000 руб., то налог взимается в размере 

10% от заработной платы, иначе если размер заработной платы менее 5000 руб., то 

налог составляет 12% от заработной платы, иначе 20%. 

Решение. 

1. в ячейку С2 следует ввести формулу: =ЕСЛИ(В2<2000;B2*10%; 
ЕСЛИ(В2<5000;B2*12%;B2*20%)) 

2. скопировать эту формулу в ячейки диапазона С3:С6. В результате в 

столбце С будет получена сумма налога, удержанная с каждого 

работника; 
3. в ячейку D2 ввести формулу для подсчета итоговой суммы: =B2-C2; 



4. скопировать эту формулу в ячейки D3:D6. 
Задача 5. Среди студентов1курса было проведено тестирование по 

тремтестам. По результатам тестирование требуется определить оценку каждого 

студента. Причем оценка вычисляется следующим образом: 

 
 
 
 
 
 

Вычислить, какое количество студентов получили оценку «2». 

Решение: 

1) в ячейки диапазона А1:F1 записать заголовки столбцов таблицы, как 

показано на рис. 1.13; 
2) в ячейки диапазона А2:А10 записать фамилии студентов; 
3) в ячейки диапазона В2:D10 записать данные о результатах 

тестирования, например, как показано на рис.1.13; 
 
 
 
 
 
 

Рисунок 1.13 – Примерный вид таблицы 

4) в ячейку Е2 записать формулу для подсчета среднего балла: 

=СРЗНАЧ(B2:D2) 
5) скопировать эту формулу на ячейки Е3:Е10; 

6) в ячейку F2 занести формулу для вычисления оценки студенту 

Иванову: 

=ЕСЛИ(E2<=2,4;2;ЕСЛИ(И(E2>=2,5;E2<=3,4);3;ЕСЛИ(И(E2>=3,5;E2

<=4,4); 4;5))) 
7) скопировать эту формулу на ячейки D3:D10 для вычисления оценок 

другим студентам; 
8) в ячейку В12 записать формулу для вычисления количества учени-ков, 

получивших оценку «2». Для этого следует воспользоваться 

статистической функцией СЧЁТЕСЛИ следующим образом: 
8.1) вызывать Мастера функций, в разделе Категории выбрать 

Статистические,в перечне статистических функций выбратьфункцию 

СЧЁТЕСЛИ; 
8.2) заполнить все поля появившегося диалогового окна, как пока-зано на 

рис. 1.14; 
8.3) нажать кнопку ОК; 
 
 
 
 
 
 
 
 



 
 
 
 
 

Рисунок 1.14 – Окно диалога функции СЧЁТЕСЛИ 

 

В результате в таблице будут получены следующие результаты, показанные 

на рис. 1.15: 

 

 
 

Рисунок 1.15 – Результаты, полученные после автоматизации вычислений 

Задание для самостоятельной работы 

Построить таблицу с заданной структурой и произвольными данными 

размером не менее десяти строк; выполнить все необходимые действия по ее 

оформлению: выравнивание, обрамление, заливка, выделение заголовков 

шрифтами и другое форматирование данных, включая установление единиц 

измерения. При построении формул предусмотреть возможность их копирования, 

т.е. использовать абсолютные и относительные ссылки. 

В каждом задании необходимо организовать: 
 встроенный контроль ввода (пункт Контроль в формулировке 

задачи).

 условное форматирование (пункт Форматирование) для указанных 

ячеек.

 результаты отобразить в виде графика (в пункте График указаны 

данные, которые должны быть связаны в диаграмме). Тип графика 

выбрать самостоятельно, исходя из наибольшей наглядности.

Исходные данные в таблицах отображены символами XXX, а вычисляемые 

символами ???. 

Замечание. Поскольку реальная нормативная база начисление 

пенсий,налогов, стипендий, оплаты коммунальных услуг и т.д., с одной стороны, 

может быть довольно сложна, а с другой, непрерывно меняется, все указанные 

соотношения в таблицах имеют условный характер и не отражают реальное 

законодательство. 

Контрольные вопросы для защиты работы 

1. Для чего нужно форматирование данных? 
2. Перечислите средства выравнивания данных. 



3. Что такое условное форматирование? Сколько и каких секций может 

быть в условном формате? 
4. Зачем нужен Мастер условного форматирования? 
5. Для чего нужна проверка ввода и где находятся эти средства? 

Перечислите три уровня контроля данных. 
6. Как скопировать в таблице только форматы? 
7. Что называется ветвлением? 
8. Как схематично можно представить простое ветвление? 
9. Какие бывают условия, используемые в ветвлениях? 

10. Каков формат записи условной функции ЕСЛИ? 

11. Какие логические функции существуют в Excel для записи сложных 

условий? Приведите формат этой записи. 

12. Как схематично можно представить сложное ветвление? 

13. С помощью чего в Excel реализуются сложные ветвления? 

14. Приведите пример сложного ветвления, реализованного в Excel? 

 
  



ЛАБОРАТОРНАЯ РАБОТА 2. ТЕХНОЛОГИЯ КОНСОЛИДАЦИИ ТАБЛИЧНЫХ 

ДАННЫХ. СВОДНЫЕ ТАБЛИЦЫ 

 
 

Цель и задачи работы: знакомство с механизмом консолидации 

данных;научиться создавать и обрабатывать сводные таблицы. 
 
 

Теоретическое обоснование 

 

В EXCEL имеется развитый аппарат быстрого и удобного извлечения и 

формирования различных обобщающих сводок. Доступ к этим средствам, в 

основном, открывает меню Данные. Здесь имеются инструменты сортировки, 

фильтрации, консолидации и, вообще, формирования разносторонних 

интегральных характеристик данных, позволяющих получить целостное 

представление об исследуемых процессах. 
Инструмент Консолидация позволяет отобразить данные исходной 

области или нескольких областей в одной итоговой таблице. Источники данных 

могут находиться на том же листе, что и итоговая таблица, на других листах той 

же книги или в других книгах или файлах. В консолидации может участвовать 

до 255 областей-источников. Для подведения итогов при консолидации 

используются такие функции, как Сумма, Количество, Среднее, Максимум, 

Минимум, Количество чисел и т.д. 

Существуют следующие варианты консолидации данных: 

 с помощью формул, где используются ссылки;

 по расположению данных для одинаково организованных 

областей-источников;

 по категориям для различающихся по своей структуре 

области данных;

 консолидация внешних данных.

При консолидации данных с помощью формул используемые в них 

ссылкимогут иметь разное представление в зависимости от взаимного 

расположения областей-источника и области-назначения: 

 все области на одном листе  в ссылках указывается адрес 

блока ячеек, например D1:C8;

 области на разных листах  в ссылках указывается 

название листа, диапазон, например лист1!D1:лист2!С8;

 области в разных книгах, на разных листах — в ссылках 

указывается название книги, название листа, диапазон, например 

[книга1]лист1!D1: [книга2]лист2!С8. 

При консолидации по расположению данных все источники имеют 

одинаковую структуру, фиксированное расположение ячеек. Используйте этот 

способ для консолидации данных листов, например, бюджетов отделов 

предприятия, созданных на основе единого шаблона. 

При консолидации по категориям области-источники содержат 

однотипные данные, но организованные в различных областях-источниках 



неодинаково. Консолидация данных по категории предусматривает 

использование в качестве основы для объединения листов заголовки строк и 

столбцов. 

Методика и порядок выполнения 

Упражнение 1. Консолидация данных 

1. Создать три таблицы, содержащие сведения о поставляемых товарах, 

по образцу, приведенному на рис.7.1. Для каждого месяца первого квартала на 

отдельном листе книги Имя_7_1 создается собственная таблица с названием 

Поставки товаров в месяце, где в месяце  в январе, в феврале, в марте. При 

создании таблиц пользоваться режимом группового заполнения листов или 

копирования данных. 
2. Переменная часть таблиц (столбцы Объем и Дата) должна 

соответствовать данным, приведенным на рис.7.1. Переименовать листы, дав им 

соответствующие имена (Янв, Фев, Мар). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.1  Таблица сведений о поставляемых товарах 

3. Вставить новый лист, дав ему имя Конс_данные. Скопировать в него 

заголовок таблицы и откорректировать его соответствующим образом (рис.7.2). 

Установить указатель активной ячейки в первую свободную ячейку А3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Рисунок 7.2  Диалоговое окно «Консолидация» 

 

4. Вызвать диалоговое  окно  Консолидация  посредством  меню Данные-

Консолидация, и, последовательно указывая в поле Ссылка необходимые адреса 

консолидируемых областей, сформировать их полный список, состоящий из трех 

записей, как представлено на рис.7.2. 

5. В поле Функция оставить функцию вычисления суммы и указать, что в 

качестве имен (названий строк) будут выбираться данные из первого столбца (А) 

консолидируемой области. Указать на необходимость создания динамической 

связи с исходными данными. 

6. Выполнить консолидацию. Сравнить полученные результаты с 

приведенными на рис.7.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.3  Результаты выполненной консолидации данных 

7. Просмотреть созданную структуру, последовательно показывая или 

скрывая уровни этой структуры. Открыть второй (внутренний) уровень для 

поставщиков из С.Петербурга и Череповца. Сравнить полученный результат с 

представленным на рис.7.4. 



8. Пользуясь меню Сервис ► Зависимости, проследить влияющие ячейки 

для ячеек С7,С10,С38. Убедиться в правильности полученных результатов. 

9. Меняя данные в ячейках листов Янв, Фев, Мар, проследить за 

автоматическим пересчетом общей итоговой суммы (ячейка С38) и частичных 

сумм ячейках С10, С26 и т.д. 

10. Сохранить  созданную  книгу  с  четырьмя  листами  под  именем Имя_7_1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.4  Результат созданной Рисунок 7.5  Образец 

таблицы структуры 

 

Выполнить консолидацию данных из разных книг. 

1. Открыть новую книгу и создать в ней одну таблицу, имеющую аналогичную 

предыдущим структуру и содержащую данные за второй квартал. Образец такой 

таблицы на рис.7.5. Назвать лист с таблицей 2кварт. Сохранить созданную книгу 

под именем Имя_7_2. 
2. Свернуть окно рабочей книги. 

3. На новом листе книги Имя_7_1 выполнить консолидацию четырех 

диапазонов ячеек  трех из листов Янв, Фев, Мар книги Имя_7_1, а четвертогоиз 

соответствующего диапазона книги Имя_7_2 листа 2кварт. Обратить внимание 

на структуру ссылки при задании области консолидации из неактивной книги. 

Проверить результат и сравнить его с тем, что представлен на рис.7.6. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.6  Результат выполнения консолидации 

 

Упражнение 2. Сводные таблицы 



1. Создать новую книгу. На первый лист этой книги ввести таблицу, 

приведенную на рис.7.7, содержащую данные о продажах строительных 

материалов. Назвать лист Продажи и сохранить книгу под именем 

Имя_8_1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.7  Таблица исходных значенийо продажах строительных 

материалов 

 

2. Воспользовавшись мастером сводных таблиц, создать на новом листе 

сводную таблицу, аналогичную приведенной на рис.7.8. Для создания 

такой таблицы на соответствующем шаге мастера сводных таблиц 

необходимо указать: 

 на 1-м шаге  Создать таблицу на основе списка или базы данных 

Excel;

 на  2-м  шаге    задать  в  качестве  области  данных  диапазон 

"$A$1:$G$11" листа Продажи;

 на 3-м шаге  определить структуру будущей сводной таблицы, 

указав, что по строкам будут размещаться данные поля Дата (даты 

продаж), а по столбцам  данные исходной таблицы в поле Название 

(названия строительных товаров). В область Данные поместить 

название поля Сумма. Поскольку по умолчанию над данными 

исходной таблицы выполняется операция суммирования, в области 

Данные появится текст Сумма по полю Сумма;

 на 4-м шаге  оставить без изменения все параметры, установленные 

по умолчанию и нажать кнопку Готово.
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.8  Результат полученной сводной таблицы 



3. Просмотреть полученную сводную таблицу. Проанализировать ее 

структуру и сравнить с образцом, представленным на рис.7.8. Дать листу со 

сводной таблицей имя Сводка_общая. 
4. Активизировать инструментальную панель Сводные таблицы. 

5. Сгруппировать данные о датах продаж по месяцам. Для этого, установив 

курсор в любую ячейку, содержащую даты продаж, щелкнуть кнопкой 

Группировать панели Сводные таблицы. В открывшемся диалоговом окне 

указать в качестве критерия группировки месяцы. Убедиться, что результат 

группировки соответствует представленному на рис.7.9. 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.9  Результат группировки по датам продаж по месяцам 

 

6. Повторить п. 5 задания, выбрав в качестве критерия группировки  

квартал. Сравнить полученный результат с представленным на рис. 7.10. 

 
 
 
 
 
 
 
 
 

Рисунок 7.10  Результат группировки по кварталу 

 

7. Повторить группировку, выбрав в качестве критерия кварталы и месяцы 

одновременно. Сопоставить полученные результаты с представленными на рис. 

7.11. 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.11  Результат группировки одновременно по кварталам и месяцам 

8. Просмотреть детализированную информацию о содержимом ячеек 

сводной таблицы. 
9. Повторить группировку данных сводной таблицы по кварталам. Для 

этой сводной таблицы установить курсор в непустую ячейку, например 

ячейкуD4 (ДоскиКв-л4),и нажать в панели Сводные таблицы кнопку 

Отобразитьдетали. Просмотреть в открывшемся листе детализированные 



данные по наименованию Доски, проданные в 4-м квартале. Сравнить результат 

с представленным на рис. 7.12. 
 
 
 
 
 
 
 
 

Рисунок 7.12  Результат группировки данных сводной таблицы по кварталам 

10. Выполнить Вычисление поля сводной таблицы для поля Название. 
Для этого дважды щелкнуть мышью по полю Название и в открывшемся 

диалоге Вычисление поля сводной таблицы установить следующие параметры: 

 имя: Название;

 ориентация: По строкам.

Остальные параметры диалога оставить без изменения. Сравнить 

результат с представленным на рис. 7.13. 

11. Самостоятельно создать три новых варианта сводной таблицы, в 

которых будет выполнено Вычисление полей сводной таблицы для полей 

Название и Дата с различной ориентацией - по строкам и по столбцам. Оценить 

все созданные варианты сводных таблиц и сделать выводы об их применимости 

для решения практических задач. 

 
 

Рисунок 7.13  Результаты выполнения сводной таблицы 

 

12. Создать на новом листе сводную таблицу, в области данных которой 

будут представлены не одно, а несколько (в примере два) полей из итоговой 

таблицы. 
13. Разместить в ячейках области данных сводной таблицы поля Сумма и 

Цена. Для выполнения этого задания необходимо на 3-ем шаге мастера сводных 

таблиц занести в область Данные соответствующие поля (Сумма и Цена) 

исходной таблицы, как это представлено на рис 7.14. 
 

 
 



 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.14  Диалоговое окно мастера сводных таблиц 

 

14. После формирования сводной таблицы сгруппировать данные о датах 

продаж по месяцам. Сравнить полученный результат со сводной 

таблицей,представленной на рис.7.15. Обратите внимание на демонстрационный 

характер задачи, а именно на то, что в результате получены суммарные данные 

по Суммам продаж и суммарные значения для Цен на товары. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рисунок 7.15  Результат формирования сводной таблицы 

 

15. Создать новую сводную таблицу, в которой вместо суммарных 

значений будут представлены средние данные по суммам продаж. Для этого 

необходимо на 3-м шаге мастера сводных таблиц определить структуру сводной 

таблицы, разместив соответствующим образом необходимые поля, после чего 

двойным щелчком мыши на поле Сумма по полю Сумма вызвать диалог 

Вычисление поля сводной таблицы, в котором указать в поле Операция действие 

 вычисление среднего значения. Завершить построение сводной таблицы и 

проанализировать полученный результат. 

16. Для полученной в п. 13 сводной таблицы изменить выполняемую над 

данными операцию, заменив вычисление среднего значения определением 

максимального значения. Для выполнения этого пункта поместите курсор в 

непустую ячейку сводной таблицы и на панели Сводные таблицы нажмите 

кнопку Поле сводной таблицы. В открывшемся диалоговом окне Вычисление 

поля сводной таблицы выберите нужную функцию и проанализируйте 

полученный результат. 



17. В качестве самостоятельного упражнения создайте новую сводную 

таблицу со структурой, которая, на Ваш взгляд, будет полезной в условиях 

данной задачи. Предъявить результаты преподавателю. 
 

Задание для самостоятельной работы 

Исходные данные для выполнения задания к лабораторной работе 

совпадают с данными для индивидуального задания лабораторной работы №1. 

Добавьте в книгу листы Январь, Февраль, Март. Скопируйте исходную таблицу 

на каждый лист и измените организацию данных в областях-источниках. 

Создайте консолидированную таблицу за I квартал. 
 

Контрольные вопросы для защиты работы 

 

1. Что такое консолидация данных, для чего она применяется? 
2. Перечислите варианты консолидации данных. 

3. Какие операции могут использоваться для подведения итогов в 

таблице консолидации? 

4. Как задается автоматическое обновление итоговой таблицы при 

изменении источника данных? 

5. Перечислите этапы создания таблицы консолидации. 

6. Какие функции можно использовать при связывании таблиц? Как 

установить связи с другой книгой? 

7. Какие функции можно использовать при объединении данных из 

нескольких таблиц при консолидации данных? 

8. С какой целью создаются сводные таблицы? Как создать сводную 

таблицу? Как быстро изменить расположение данных, 

сгруппировать данные? 

9. Какие функции обработки можно использовать в сводных таблицах? 

Для чего используется поле "страница"? 
  



ЛАБОРАТОРНАЯ РАБОТА 3. "РАБОТА СО ШРИФТОМ. ТЕКСТОВЫЕЭФФЕКТЫ". 

ЧАСТЬ 1 

Работа со шрифтом - интересная, многоплановая и достаточно сложная 

часть работы в компьютерном дизайне. Поэтому стоит рассмотреть различные 

дизайнерские приемы в создании текстовых эффектов. 
 

Надпись огнем 

Создайте файл произвольного размера (Ctrl+N). При этом проследите, 

чтобы цвет фона был черный, а в качестве цветовой модели (Color Mode) 

выбрана Grayscale (Полутоновый). Напишите текст hot белым цветом, шрифт 

Arial Bold. 

Если вас не устраивает размер или расположение надписи, то текст можно 

отредактировать прямо в окне изображения. Для этого нажмите сочетание 

клавиш Ctrl+T. Откроется окно, в котором устанавливается размер букв, 

положение надписи и ее наклон. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Отредактировав текст, откройте палитру Layers (Слои). Ваше изображение 

должно содержать два слоя: фоновый слой и слой с текстом. Переведите текст в 

растр. Склейте слой с текстом и слой фона, для чего выполните команду Layer -

-> Merge Layers (Слой --> Склеить слои) или нажмите сочетание клавиш Ctrl+E. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.1. Исходный текст 
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Поверните изображение на 90? против часовой стрелки: Image -> Rotate 

Canvas -> 90 CCW (Изображение -> Повернуть холст -> 90 градусов против часовой 

стрелки). 

Примените фильтр Wind (Ветер): Filter -> Stylize -> Wind (Фильтр -> 

Стилизация -> Ветер) (рис. 1.2). Установите следующие настройки фильтра: 

Method (Метод) - Wind (Ветер), Direction (Направление) - From the Right (Ветер 

справа). 

Чтобы увеличить язычки пламени, этот фильтр стоит применить несколько 

раз. 

Теперь примените к изображению фильтр Glass (Стекло): Filter -> Distort - 

Glass (Фильтр -> Искажение -> Стекло) (рис. 1.3). Установите следующие 

параметры: Distortion (Искажение) 1, Smoothness (Смягчение) 3, Texture (Тексту-

ра) Frosted, Scaling (Масштаб) 100%. 

Верните изображение в исходное положение: Image -> Rotate Canvas ->90 

CW (Изображение -> Повернуть холст -> 90 градусов по часовой стрелке). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.2. Диалоговое окно фильтра Wind (Ветер) 

 

Теперь нужно придать пламени движения. Для этого воспользуйтесь 

фильтром Ripple (Рябь): Filter -> Distort -> Ripple (Фильтр -> Искажение -> Рябь). 

Установите средний (Medium) размер ряби (Size) и сделайте параметр Amount 

(Эффект) равным 100% (рис. 1.5). 
 



Пришло время раскрасить пламя. Переведите изображение в режим 

индексированных цветов: Image -> Mode -> Indexed Color (Изображение -> 

Режим -> Индексированные цвета). Затем Image -> Mode -> Color Table 

(Изображение -Режим -> Палитра). Выберите таблицу Black Body. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.3. Диалоговое окно фильтра Glass (Стекло) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.4. Текст после применения фильтра Glass (Стекло) 
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Рис. 1.5. Диалоговое окно фильтра Ripple (Рябь) 

Готовый эффект показан на рис. 1.6. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.6. Огненная надпись 

2. Пишем льдом 
Создайте заготовку произвольного формата в режиме Grayscale 

(Полутоновый). Цвет фона должен быть белым, а цвет переднего плана - черным 

(данные цвета являются основными цветами по умолчанию, поэтому их можно 

установить, не переходя в цветовую палитру, нажатием клавиши D). 

Напишите текст frost, шрифт Century 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.1. Исходная надпись 

Откройте палитру Layer (Слой) и щелкните правой кнопкой мыши по слою 

с текстом. В появившемся меню выберите пункт Rasterize Layer (Растрировать 

слой). Затем склейте его с нижним слоем. Выделите текст волшебной палочкой, 

для чего выделите одну букву, затем щелкните по выделению правой клавишей 

мыши и выберите пункт Similar (Подобно). 

Выполните кристаллизацию надписи: Filter -> Pixelate -> Crystallize 

(Фильтр -> Оформление -> Кристаллизация) (рис. 2.2). Установите размер 

ячейки кристаллизации равным 10. Так как ледяная поверхность не идеально 

гладкая, придадим ей шероховатость. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.2. Диалоговое окно фильтра Crystallize (Кристаллизация) 



3

9 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.3. Диалоговое окно фильтра Add Noise (Добавить шум) 

Для этого следует добавить шум: Filter -> Noise -> Add Noise (Фильтр -> 

Шум -> Добавить шум) (рис. 2.3). Задайте значение Amount (Эффект) равным 70 

% и установите флажок Monochromatic (Монохромный). После выполнения 

вышеописанных действий должен получиться результат, изображенный на 

рисунке 2.4. 
 
 
 
 
 
 
 
 
 

Рис. 2.4. Надпись после кристаллизации и добавления шума 

 

Смягчите эффект, полученный после кристаллизации и добавления шума, 

применив фильтр Gaussian Blur: Filter -> Blur -> Gaussian Blur (Фильтр -> 

Смазывание -> Смазывание Гаусса). Радиус размытия возьмите около 2. 

Следующий этап - цветокоррекция с использованием тоновых кривых. 

Выберите команду Image -> Adjustments -> Curves (Изображение -> Регулировки 

-> Кривые) или нажмите сочетание клавиш Ctrl+M. Попытайтесь нарисовать 

кривую, похожую на ту, которая изображена на рис. 2.5. 
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Рис. 2.5. Кривая, примененная в примере 

Теперь следует создать сосульки. Для этого выберите сначала команду 

Image -> Rotate Canvas -> 90 CW (Изображение -> Повернуть холст -> 90 граду-

сов по часовой стрелке), а затем Filter -> Stylize -> Wind (Фильтр -> Стилизация 

-> Ветер). Настройка фильтра Wind (Ветер): Method (Метод) - Wind (Ветер), 

Direction (Направление) - From the Right (Ветер справа). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.6. Текст после применения фильтра Wind (Ветер) 



Верните холст в исходное положение командой Image -> Rotate Canvas -> 

90 CCW (Изображение -> Повернуть холст -> 90 градусов против часовой 

стрелки). 

Теперь осталось раскрасить лед. Переведите изображение в цветовой 

режим RGB: Image -> Mode -> RGB Color (Изображение -> Режим -> RGB). Те-

перь выберите команду меню Image -> Adjustments -> Hue / Saturation (Изобра-

жение -> Регулировки -> Цвет / Насыщенность). Установите флажок Colorize 

(Тонирование) и следующие параметры: тон (Hue) 198, насыщенность 

(Saturation) 54, яркость (Lightness) 0. 

Для того, чтобы лед засверкал и заискрился, выберите инструмент Brush 

(Кисть) и активизируйте режим Airbrush Capabilities (Возможности аэрографа). 

Воспользуйтесь дополнительными кистями в виде звезд и снежинок для 

создания эффекта искрящегося и переливающегося на солнце льда. 

Итоговое изображение представлено на рис. 2.7. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.7. Итоговое изображение 
  



ЛАБОРАТОРНАЯ РАБОТА 4. "РАБОТА СО ШРИФТОМ. ТЕКСТОВЫЕЭФФЕКТЫ". 

ЧАСТЬ 2 

 

1. Надпись из воды 
Имитация воды - одна из самых сложных задач в компьютерной графике, 

причем не только двухмерной, но и трехмерной. В этом примере предложен 

способ имитации воды сразу в двух проявлениях: надпись из воды на фоне 

водной текстуры. 

Создайте исходное изображение средних размеров в цветовом режиме 

RGB. Убедившись, что цвета выставлены по умолчанию (D), примените к нему 

фильтр Clouds (Облака): Filter -> Render -> Clouds (Фильтр -> Освещение -> 

Облака), который добавит относительно случайным образом формируемую 

текстуру. 

Затем выполните фильтр Chrome (Хром): Filter -> Sketch -> Chrome 

(Фильтр -> Эскиз -> Хром) с настройками, показанными на рис. 1.1. 

Окрасьте воду в голубой цвет. Воспользуйтесь цветокорректирующим 

средством Color Balance (Цветовой баланс), которое можно запустить горячим 

сочетанием клавиш Ctrl+B. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.1. Настройки фильтра Chrome (Хром) 

В открывшемся диалоговом окне в опции Color Levels (Цветовые уровни) 

введите значения -67 26 74. Заготовка окрасится в естественные для воды 

оттенки. 
 
 
 
 
 
 
 
 
 
 



 
 

Для того, чтобы сделать текстуру воды более привлекательной, 

необходимо проделать ряд дополнительных действий. 

Создайте новый слой (Ctrl+Shift+N). Повторите применение фильтров 

Clouds (Облака) и Chrome (Хром), которое было использовано для рисования 

воды на первом слое. Затем запустите инструмент Hue / Saturation (Цвет / 

Насыщенность) и примените его, включив опцию Colorize (Тонирование), со 

следующими настройками: Hue (Цвет) 207, Saturation (Насыщенность) 47, 

Lightness (Яркость) -20. В палитре Layers (Слои) установите параметр Opacity 

(Непрозрачность) 60 %. Склейте слои. Возможно, понадобится добавить немного 

насыщенности оттенкам при помощи того же Hue / Saturation. 

Пришло время создать надпись из воды. Для этого создайте еще один слой. 

Напишите белым цветом слово aqua, шрифт Arial Rounded MT Bold. Примените 

к надписи фильтр Gaussian Blur: Filter -> Blur -> Gaussian Blur (Фильтр -

>Смазывание -> Смазывание Гаусса). Радиус размытия возьмите в 1 px. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Затем откройте палитру Layers (Слои) и установите для только что 

созданного текстового слоя следующие настройки: Fill (Заливка) 0, Opacity 

(Непрозрачность) 80. В результате надпись исчезнет, но именно это и нужно для 

создания эффекта. Продублируйте слой с надписью, перетянув его в палитре 

Layers (Слои) на пиктограмму в виде белого листа бумаги. 

Активируйте первый слой с надписью и примените к нему эффект Drop 

Shadow (Внешняя тень): Layer -> Layer Style -> Drop Shadow (Слой -> Стиль слоя 

-> Внешняя тень) с настройками, показанными на рис. 1.2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Рис. 1.2. Настройки Drop Shadow (Внешняя тень) для первого слоя 

надписи. 

Не закрывая диалогового окна, переключитесь на эффект Inner Shadow 

(Внутренняя тень) и повторите настройки, которые можно видеть на рис. 1.3. 

Параметры для третьего эффекта Bevel and Emboss (Скос и рельеф) смотрите на 

рис. 1.4. 

Завершив работу с этим слоем, переключитесь на второй слой. Примените 

к нему эффект Bevel and Emboss: Layer -> Layer Style -> Bevel and Emboss (Слой 

-> Стиль слоя -> Скос и рельеф) с настройками, показанными на рис. 1.5. 

Убедитесь, что активен второй слой с надписью и осветлите его при 

помощи Hue / Saturation: Image -> Adjustments -> Hue / Saturation (Изображение -

> Регулировки -> Цвет / Насыщенность) с настройками, показанными на рис. 1.6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.3. Настройки Inner Shadow (Внутренняя тень) для первого слоя 

надписи 

 

 

 

 

 

 

 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.4. Настройки Bevel and Emboss (Скос и рельеф) для первого слоя 

надписи 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.5. Настройки Bevel and Emboss (Скос и рельеф) для второго слоя 

надписи 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.6. Настройки Hue / Saturation (Цвет / Насыщенность) 

Активируйте палитру Layers (Слои) и задайте для второго слоя надписи 

параметры, значения которых можно видеть на рис. 1.7.Склейте все слои 

(Ctrl+Shift+E). Итоговое изображение показано на рис.1.8. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.7. Настройки для второго слоя надписи в палитре Layers (Слои) 

Рис. 1.8. Надпись из воды 

 

2. Лазерная надпись 
Создайте новое изображение с белым фоном. Черным цветом напишите на 

изображении текст laser, шрифт Trebuchet MS. 

Примените к полученному изображению фильтр Plastic Wrap 

(Целлофановая упаковка): Filter -> Artistic -> Plastic Wrap (Фильтр -> Имитация 

-> Целлофановая упаковка). Необходимые настройки показаны на рис. 2.2. 

Теперь необходимо сделать светлые полосы более контрастными по 

отношению к темному цвету букв. Для этого выберите команду Image -> 

Adjustments -> Curves (Изображение -> Регулировки -> Кривые). Постройте 

кривую, близкую к той, что изображена на рис. 2.3. 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.1. Исходное изображение 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.2. Настройки фильтра Plastic Wrap (Целлофановая упаковка) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

Рис. 2.3. Вид и параметры кривой 

Сделайте лазерный луч цветным. Для этого используйте следующий 

способ: Image -> Adjustments -> Selective Color (Изображение -> Настройки 

->Вы-борочный цвет). Настройки изображены на рис. 2.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.4. Диалоговое окно Selective Color (Выборочный цвет) 

Далее выделите текст и создайте новый слой через копирование, щелкнув 

правой кнопкой мыши в области выделения и выбрав в раскрывшемся меню 

пункт Layer via Copy (Слой через копирование). В результате вы получите слой, 

на котором все будет прозрачным, кроме текста. 
 

Чтобы лазерный текст выглядел более эффектно, залейте при помощи 

инструмента Paint Bucket (Заливка) первый слой черным цветом (рис. 2.5). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.5. Черный фон усиливает эффектность 

 

Создайте легкое сияние вокруг букв. Для этого воспользуйтесь эффектами 

слоя Outer Glow (Внешнее свечение): Layer -> Layer Style -> Outer Glow (Слой -

> Стили слоя -> Внешнее свечение). Настройки представлены на рис. 2.6. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.6. Применение эффекта Outer Glow (Внешнее свечение) 

Готовая лазерная надпись изображена на рис. 2.7. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.7. Лазерная надпись 

 
 

ЛАБОРАТОРНАЯ РАБОТА 5. "СОЗДАНИЕ РАЗЛИЧНЫХ ЭФФЕКТОВ PHOTOSHOP " 

 

1. Штрих-код 
Создайте новое изображение (Ctrl+N) в любой цветовой модели. Размеры 

изображения должны быть небольшими - оптимально 300100 пикселов. 

Фоновый цвет - белый. 

В начале примените фильтр Add Noise: Filter -> Noise -> Add Noise 

(Фильтр -> Шум -> Добавить шум) с настройками, показанными на рис. 1.1. 
 

 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.1.Настройки фильтра Add Noise (Добавить шум) 

Превратите шум в полосы. Для этого примените фильтр Motion Blur 

(Смазывание движения) с настройками, показанными на рис. 1.2. 

Результат последнего действия уже напоминает штрих-код, однако 

полосок слишком много, и они слишком тонкие. Для того, чтобы это исправить, 

увеличьте контраст изображения. Это можно сделать несколькими способами, 

но наиболее эффективным будет увеличение контраста с помощью кривых. 

Необходимые настройки показаны на рис. 1.3. 

Если все сделано правильно, результат будет похож на рис. 1.4. 

Текстура готова. Однако для большей убедительности нужно выполнить 

еще два действия. 

Запустите инструмент Rectangle Marquee (Прямоугольное выделение), 

выделите фрагмент в нижней части изображения и нажмите клавишу Delete. 

 

После этого инструментом Horizontal Type (Горизонтальный текст) 

наберите в созданной области произвольный набор цифр. Шрифт и размеры 

подберите на глаз. Примените Brightness / Contrast (Яркость / Контраст) (рис. 

1.5). 

Готовое изображение показано на рис. 1.6. 

 

 

 

 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.2. Использование фильтра Motion Blur (Размытие в движении) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 1.3. Пример кривой 
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Рис. 1.4. Работа после увеличения контраста 

 
 
 
 
 
 
 
 
 
 

Рис. 1.5. Использование команды Brightness / Contrast (Яркость / Кон-траст) 

 
 
 
 
 
 
 
 
 
 

Рис. 1.6. Готовый штрих-код 

2. Эффект Скорости 
Имитация скорости - это один из наиболее востребованных приемов в 

профессиональном дизайне. Дело в том, что скорость позволяет очень хорошо 

задать настроение работы или подчеркнуть те или иные качества 

рекламируемого предмета, а готовые фотографии такого содержания 

чрезвычайно редки. 

В данной лабораторной работе предлагается создать имитацию 

автомобиля, движущегося на большой скорости. Исходное изображение 

представлено на рис. 2.1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.1. Исходное изображение Начните с крутящихся колес. Запустите 

инструмент Elliptical Marquee (Эллиптическое выделение) и выделите колесо. 

Затем примените фильтр Radial Blur (Радиальное размытие) из группы Blur 



(Размытие) с настройками, показанными на рис. 2.2. Затем повторите это 

действие для второго колеса. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.2. Настройки фильтра Radial Blur (Радиальное размытие) 

 

Выделите корпус автомобиля, применив наиболее удобный для вас 

инструмент выделения. Вырежьте полученную область на новый слой, для чего 

щелкните правой кнопкой мыши по фоновому слою и из контекстного меню 

выберите команду Layer via copy (Слой через копирование). 

Нижний из двух одинаковых слоев необходимо размыть. Для этого 

отлично подходит специальный фильтр: Filter -> Blur -> Motion Blur (Фильтр -> 

Смазывание -> Смазывание движения). Диалоговое окно данного фильтра 

представлено на рис. 2.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.3. Колеса в движении 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис.2.4. Диалоговое окно фильтра Motion Blur (Смазывание движения)  

Для имитации скорости необходимо передвинуть верхний слой так, чтобы два 

нижних образовывали не ореол, а "шлейф" позади движущегося объек-та. 

Возможно, какие-то элементы корпуса придется затереть при помощи ин-

струмента Eraser (Ластик). 

Однако, автомобиль, несущийся на огромной скорости без водителя – 

этодостаточно нелепо. Поэтому дорисуйте контур головы человека при помощи 

кисти и немного размойте его. Установите в палитре Layers (Слои) параметр 

Opacity (Непрозрачность) 40 %. 
 

Результат представлен на рис. 2.5. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 2.5. Автомобиль в движении 

3. Кристаллы 



 

Создайте новое изображение размером 400400 пикселов в цветовом 

режиме RGB. Используя инструмент Paint Bucket (Заливка), залейте его черным 

цветом. 

Затем примените фильтр Lens Flare: Filter -> Render -> Lens Flare (Фильтр 

-> Освещение -> Блик) с показанными на рис. 3.1 настройками. Обратите 

внимание на то, что блик должен быть расположен по центру изображения. 

Увеличьте при помощи Canvas Size: Image -> Canvas Size (Изображение - 

> Размер холста) размеры изображения в два раза. 
Теперь следует превратить блик в достаточно большое разноцветное 

пятно. Для этого воспользуйтесь фильтром Fresco: Filter -> Artistic -> Fresco 

(Фильтр -> Художественные -> Фреска) (рис. 3.2). 

Сформируйте кристаллы. Для этого используйте фильтр Extrude: Filter -> 

Stylize -> Extrude (Фильтр -> Стилизация -> Выдавливание). Необходимые 

настройки изображены на рис. 3.3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3.1. Диалоговое окно фильтра Lens Flare (Блик) 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3.2. Параметры фильтра Fresco (Фреска) 

 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3.3. Настройки фильтра Extrude (Выдавливание) 

Окрасьте кристаллы в один тон. Для этого используйте инструмент Hue / 

Saturation (Оттенок / Насыщенность) в режиме Colorize (Окраска). Готовое 

изображение представлено на рис. 3.4. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3.4. Изображение кристаллов 

 

 

ЛАБОРАТОРНАЯ РАБОТА 6. ЗНАКОМСТВО С FLASH-ТЕХНОЛОГИЕЙ 

 

Научимся создавать анимацию, управляемую клавишами клавиатуры. 

Герой. 

Определитесь с выбором героя вашей игры. 

Создадим новый документ (Modify-Document/Модификация-Документ). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

Нарисуем фигуру (можно сделать ее из нескольких составных частей, 

например круг с глазами). Выделим все составные части фигуры с контуром и 

преобразуем в символ (F8). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Укажем тип – Movie clip / Фрагмент ролика. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Выделите символ. В свойствах пропишите Instance name/Имя экземпляра 

– hero. 
 
 
 
 
 
 
 
 
 
 
 
 

Выделите символ. Откроем панель Actions (F9) и пропишем следующий 

код: 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

_x--; 

} 

if (Key.isDown(Key.RIGHT)) { 

_x++; 



} 

if (Key.isDown(Key.UP)) { 

_y--; 

} 

if (Key.isDown(Key.DOWN)) { 

_y++; 

} 

 

} 

 

Обработчик события кадра проверяет, если клавиша нажата и 

инкрементирует или декрементирует x или y позицию в соответствии с нажатой 

клавишей. Протестируйте ролик (Ctrl+Enter): понажимайте стрелки для контроля 

над героем. 

Найдите символ в библиотеке символов (Ctrl+L). Откройте символ двойным 

щелчком. Обратите внимание, что внутри символа своя шкала кадров. Таким 

образом, героя можно анимировать. Можно заменить символ на Винни-пуха из 

предыдущей части работы. 

Энергия 

Итак, наш герой двигается с фиксированной скоростью. Установим 

переменною для хранения скорости. Это очень важно, так как если вы захотите 

разработать различные уровни, и скорость героя будет меняться в зависимости от 

уровня, то нужно будет лишь менять значение переменной. 

Итак, создаем переменную "power", для того, чтобы управлять скоростью 

перемещения героя. 

Изменимнашкод: 

onClipEvent (load) { 

power = 3; 

} 

onClipEvent (enterFrame) { 

 

if (Key.isDown(Key.LEFT)) { 

_x -= power; 

} 

if (Key.isDown(Key.RIGHT)) { 

_x += power; 

} 

 

if (Key.isDown(Key.UP)) { 

_y -= power; 

} 

if (Key.isDown(Key.DOWN)) { 

_y += power; 

} 

} 

 



Теперь вы можете изменять скорость вашего героя, только корректируя 

переменную "power". Чем выше значение power, тем быстрее герой двигается. 

Протестируйте ролик, изменяя значение переменной. 
 

Скорость 

Итак, наш герой движется с одинаковой скоростью, и всегда стартует без 

движения. Теперь нужно что-то вроде ускорения и, в конечном счете, началь-ная 

скорость. 

Изменимнашкод: 

onClipEvent (load) { 

power = 0.2; 

yspeed = 0; 

xspeed = 0; 

} 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

xspeed -= power; 

 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

if (Key.isDown(Key.UP)) { 

yspeed -= power; 

 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed += power; 

} 

_y += yspeed; 

_x += xspeed; 

} 

 

Заметьте, теперь power прибавляется к скорости, с этим надо играть 

осторожно, иначе наш герой будет двигаться слишком быстро. Начальные 

значения yspeed и xspeed инициализируются 0, но можно изменять их, чтобы 

придать герою движения. Теперь чем больше вы давите на клавишу, тем больше 

скорость вашего героя и тем труднее ему изменить направление. 

Трение 

Теперь задействуем трение, потому герой не должен двигаться вечно, ес-ли 

пользователь не нажимает клавиш. Сделаем так, чтобы герой замедлял дви-жение, 

если клавиши не нажаты. 
 

Изменимнашкод: 

onClipEvent (load) { 

 

power = 0.3; 

yspeed = 0; 

xspeed = 0; 



friction = 0.95; 

} 

 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

xspeed -= power; 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

 

if (Key.isDown(Key.UP)) { 

yspeed -= power; 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed += power; 

} 

xspeed *= friction; 

yspeed *= friction; 

_y += yspeed; 

_x += xspeed; 

} 

 

Итак, мы задействовали коэффициент трения меньше 1, чтобы 

воздействовать на скорость героя. Теперь, когда пользователь нажимает на 

клавишу, герой начнет движение, но когда он отпустит клавишу, герой постепенно 

остановится. Чем выше коэффициент трения (всегда меньше 1, запомните), тем 

медленней наш герой будет терять скорость. 

Гравитация 

Попробуем сымитировать гравитацию. Герой будет падать под воздей- 

ствием силы тяжести. 

Изменим наш код: 

onClipEvent (load) { 

 

power = 0.3; 

yspeed = 0; 

xspeed = 0; 

friction = 0.95; 

gravity = 0.1 

} 

onClipEvent (enterFrame) { 

 

if (Key.isDown(Key.LEFT)) { 

xspeed -= power; 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

 



if (Key.isDown(Key.UP)) { 

yspeed -= power; 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed += power; 

} 

xspeed *= friction; 

 

yspeed += gravity; 

_y += yspeed; 

_x += xspeed; 

} 

 

Тяга 

Если есть сила тяжести, нужна и тяга. Сделаем более сложное перемеще- 

 

ние вверх, так как герой живет в мире, где существует сила тяжести. 

onClipEvent (load) { 

power = 0.3; 

yspeed = 0; 

xspeed = 0; 

friction = 0.95; 

 

gravity = 0.1; 

thrust = 0.75; 

} 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

xspeed -= power; 

 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

if (Key.isDown(Key.UP)) { 

yspeed -= power*thrust; 

 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed += power*thrust; 

} 

xspeed *= friction; 

yspeed += gravity; 

 

_y += yspeed; 

_x += xspeed; 

} 

 



Как Вы видите коэфициент тяги "thrust" (меньше чем 1), воздействует на 

движение вверх, ослабляя его и делая более сложным. 

Ветер 

Попробуем сделать ролик ветреным. 
 

onClipEvent (load) { 

power = 0.3; 

yspeed = 0; 

xspeed = 0; 

friction = 0.95; 

gravity = 0.1; 

 

thrust = 0.75; 

wind = 0.09; 

} 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

xspeed -= power; 

} 

 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

if (Key.isDown(Key.UP)) { 

yspeed -= power*thrust; 

} 

 

if (Key.isDown(Key.DOWN)) { 

yspeed += power*thrust; 

} 

xspeed += wind; 

xspeed *= friction; 

yspeed += gravity; 

_y += yspeed; 

 

_x += xspeed; 

} 

 

Ветер влияет на сторону движения, положительно влияет на движение 

вправо и отрицательно влево. Изменяйте значения переменных и найдите 

идеальное сочетание реализма и играбельности. 

 

Поворот 

Теперь последней штрих. Сделаем так, чтобы герой вращался по часовой 

 

стрелке при движении вправо, а против часовой при движении влево 

onClipEvent (load) { 



 

power = 0.65; 

yspeed = 0; 

xspeed = 0; 

 

friction = 0.99; 

gravity = 0.1; 

thrust = 0.75; 

wind = 0.05; 

} 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

 

xspeed -= power; 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed += power; 

} 

if (Key.isDown(Key.UP)) { 

 

yspeed -= power*thrust; 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed += power*thrust; 

} 

xspeed += wind; 

xspeed *= friction; 

 

yspeed += gravity; 

_y += yspeed; 

_x += xspeed; 

_rotation += xspeed; 

} 

Простоприравняемrotationгерояегоxspeed. 
 

Границы 

Каждая игра имеет границы, поэтому необходимо создать переменную 

("wall"). 

Нарисуем прямоугольник с толстыми стенками. 

Преобразуем фигуру в символ и укажем свойства: 

 
 
 
 
 
 
 
 
 



 
 
 

Пусть герой не может касаться стенок, так что код следующий: 

onClipEvent (load) { 

yspeed = 0; 

 

xspeed = 0; 

wind = 0.00; 

power = 0.65; 

gravity = 0.1; 

upconstant = 0.75; 

friction = 0.99; 

 

} 

onClipEvent (enterFrame) { 

if (Key.isDown(Key.LEFT)) { 

xspeed = xspeed-power; 

} 

if (Key.isDown(Key.RIGHT)) { 

xspeed = xspeed+power; 

 

} 

if (Key.isDown(Key.UP)) { 

yspeed = yspeed-power*upconstant; 

} 

if (Key.isDown(Key.DOWN)) { 

yspeed = yspeed+power*upconstant; 

 

} 

xspeed = (xspeed+wind)*friction; 

yspeed = yspeed+gravity; 

_y = _y+yspeed; 

_x = _x+xspeed; 

_rotation = _rotation+xspeed; 

 

if (_root.wall.hitTest(_x, _y, true)) {//проверка падения героя на стенку от 

центра героя 

 

xspeed = 0; 

yspeed = 0; 

_x = 120; 

_y = 120;//сброс позиции героя в случае смерти 

} 

} 
 

 



ЛАБОРАТОРНАЯ РАБОТА 7. РАБОТА СО ЗВУКОМ ВО FLASH 

 

Использование звука позволяет существенно усовершенствовать Flash-

проекты. Звук дополняет визуальный ряд, воздействуя на другой канал 

чувственного восприятия зрителя, и тем самым делает анимацию более 

убедительной. 

По звуку, произведенному падающей болванкой, будет ясно, железная она 

или деревянная, даже если она не залита текстурой. 

Можно сказать, что звук придает проекту новое измерение. В данном уроке 

мы рассмотрим, какой же инструментарий предлагает Flash 2004 для работы со 

звуком. 

Некоторые Базовые Понятия 

Прежде чем изложить принципы работы со звуком во Flash, следует 

напомнить читателю некоторые базовые понятия и термины. 

Процесс преобразования аналогового звука в цифровой определяется двумя 

параметрами: частотой дискретизации и разрядностью. Устройство 

преобразования аналогового сигнала в цифровой измеряет амплитуду аналогового 

сигнала через малые промежутки времени и выдает результаты измерений в виде 

чисел. Результат дискретизации не является точным аналогом непрерывного 

электрического сигнала. Соответствие тем полнее, чем чаще происходят 

измерениячем они точнее. Частота, с которой производятся измерения, называется 

частотой дискретизации (Sampling Rate). 
Чем меньше частота дискретизации, тем больше запись будет отличаться от 

исходной. Например, для музыки на CD требуется частота дискретизации 44,1 кГц, 

для музыкальных клипов на радио FM достаточно 22,05 кГц, а для речи 

допускается всего 5 кГц. 
На точность измерений амплитуды указывает число бит, использующихся 

для представления результата измерений (Sample Size). Например, каждый отсчет 

8-битного звука может принимать 256 значений, 16-битного — 65 536 и т.д. 

Музыка на компакт-диске требует 16 бит, а музыкальные клипы на радио 

диапазона FM — 8 бит. 
Звуковой файл может содержать несколько каналов: один канал — моно, два 

канала — стерео и т.п. В соответствии с вышеизложенным размер звукового файла 

будет определяться произведением сомножителей: частота дискретизации (Гц), 

разрядность (бит), продолжительность (с), количество каналов. Чем меньший 

объем занимает файл, тем быстрее удается передать его из Web потребителю. 
Если вам нужно озвучить героя или прочитать некоторый текст, то придется 

записать речь самому. Наиболее простой способ — это вызвать программу для 

записи звука, входящую в стандартную поставку Windows XP, по команде 
Accessories => Entertainment => Sound Recorder (рис. 2) 

изаписатьнужныйзвуковойфайл. Интерфейс программы полностью повторяет 

клавиши обычного магнитофона. 



 
 
 
 
 
 
 
 
 
 
 

Рис. 2. Программа Sound Recorder 

Добавление Звука Во Flash 

 

Flash предлагает множество инструментов для встраивания звуков в 

анимацию. Можно использовать звуки, раздающиеся непрерывно, независимо от 

монтажной линейки, или синхронизировать мультипликацию со звуковой 

дорожкой. Можно добавить звуки к кнопкам, чтобы усилить их интерактивность, 

можно заставить звуки постепенно появляться или исчезать для получения 

различных эффектов. 

При передаче озвученной Flash-анимации из Web критичным является 

размер файла. При создании Flash-фильма программа предоставляет пользователю 

набор опций сжатия звука для управления качеством и размером звуковых файлов 

в экспортируемом Flash-клипе. Рассмотрим все эти возможности более подробно. 

Импорт Звуков 

Рассмотрим простой пример. Откроем короткий звуковой файл в формате 

Waw и импортируем его в библиотеку, используя команду File => Import => Import 

to Library. Соответственно в окне Library появится звуковой файл. Активизировав 

его щелчком мыши (рис. 3), можно просмотреть его графическое отображение и 

проиграть, нажав на кнопку «Воспроизведение». 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 3. Графическое отображение звука 

 



Далее создайте экземпляр звука, перетащив его из библиотеки на сцену, в 

результате чего звук будет добавлен в текущий кадр (рис. 4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 4. Создание экземпляра звука 

 

В этом, самом простом, случае (см. «gudok.fla») Flash-фильм состоит из 

аудиофайла без анимации. Прежде чем перейти к рассмотрению совместного 

использования анимации и звука, следует рассказать о том, какие варианты 

синхронизации звука и анимации предлагает программа Flash. 
Различные Виды Синхронизации Режим синхронизации Event 
 
Данный тип синхронизации используется по умолчанию. Экземпляр звука, 

использующий данную синхронизацию, называют событийным. Он начинает 

воспроизводиться, когда проигрывается ключевой кадр, в котором он расположен, 

и исполняется полностью, независимо от длины линейки, даже если мувиклип 

останавливается. То есть если экземпляр пятисекундного звука поместить в кадрах, 

которые проигрываются за секунду, то он все равно прозвучит до конца. 
 
Повторное использование событийного звука не приводит к существенному 

увеличению объема результирующего файла. При загрузке фильма из сети 

событийный звук может быть воспроизведен только после полной загрузки. 
Рассмотрим пример (звук-1.fla) использования событийного звука (рис. 5). 



В нашем примере шарик падает и сплющивается. В момент, когда 

начинаетсядеформация шарика (в 20-м кадре), включается событийный звук. На 

рис. 5 начало графического отображения звука видно в кадрах 20-23. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 5. Озвучивание падения мяча 

 

Несмотря на то, что на 23-м кадре фильм заканчивается, звук удара 

проигрывается до конца. 

Следует отметить, что событийные звуки могут накладываться сами на себя 

(микшироваться). Поясним это на примере (рис. 6). На монтажной линейке 

имеются два слоя. Слой Тext содержит 25 кадров со статичным поздравитель-ным 

текстом, а слой Sound — звуковой файл с поздравительной речью на 4,9 с. 

Установлен режим синхронизации Event, количество повторов Repeat = 1. Частота 

кадров составляет 10 кадров/с. При воспроизведении этого фильма будет 

происходить следующее: стартует выполнение звукового файла (который будет 

воспроизводиться 4,9 с), но через 2,5 с все 25 кадров фильма закончатся, и он 

запустится снова, поэтому речь будет накладываться сама на себя. Данный эффект 

иллюстрируется примером (mikshirovaniezvuka.fla). 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 6. Пример с наложением речи 

Режим синхронизации Start 

Данный вид синхронизации исключает возможность наложения звуков. Если 

в примере, рассмотренном на рис. 6, мы поменяем режим синхронизации с Event 

на Start (рис. 7), то получим фильм, в котором не будет наложения 

(primerrejimastart.swf). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Рис. 7. Пример, в котором отсутствует наложение речи Режим 

синхронизации Stop 

 

Режим Stop останавливает воспроизведение экземпляров того же звука. 

На рис. 8 показан пример, в котором в слое sound-2 используется звук типа 

Stop. Как только воспроизводящая головка входит в кадр, содержащий звук ти-па 

Stop (в нашем примере 15-й кадр), воспроизводящиеся в этот момент экзем-пляры 

того же звука останавливаются. Данный пример иллюстрируется филь-мом 

(primersinxronizaciitipastop.fla). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 8. Пример использования режима синхронизации Stop Режим 

синхронизации Stream 

 

Режим синхронизации Stream используется для синхронизации потокового 

звука и анимации для воспроизведения в Web. Flash подстраивает мультипликацию 

под темп потокового звука. Потоковый звук имеет приоритет перед визуальным 

рядом: если Flash не может прорисовывать кадры мультипликации достаточно 

быстро, он пропускает их, а целостность звучания сохраняется. В отличие от звуков 

события, потоковый звук прекращается, если останавливается анимация. Также 

потоковый звук никогда не может играть дольше, чем воспроизводится количество 

кадров, которое он занимает. 

Пример потокового звука — голос персонажа мультипликации, 

воспроизводимый в течение большого количества кадров. 
 



Зацикливание звука 

Для того чтобы снабдить клип фоновой музыкой, не сильно увеличив при 

этом вес файла, применяют зацикливание воспроизведения звука. В качестве 

исходных звуков в данном случае используются так называемые звуковые пет-ли 

(Sound Loops). 

Рассмотрим пример, в котором нужно обеспечить звучание фоновой музыки 

течение 8,2 мин, имея Loop-фрагмент на 8,2 с. Задача решается просто: 

устанавливаем количество повторов 60, и фоновая музыка обеспечена (рис. 10). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 10. Пример использования фоновой музыки 

 

В результате получим следующий пример: loop1.swf. Обратите внимание: 

несмотря на то, что звуковой файл повторяется многократно, вес SWF-файла 

остается постоянным при однократном и многократном зацикливании. 
Теперь посмотрим, что будет, если мы поместим тот же Loop-фрагмент в 

режиме синхронизации Stream и зададим разное количество повторов Repeat. При 

однократном повторе (при частоте 12 кадров/с) понадобится создать на монтажной 

линейке как минимум 97 кадров (рис. 11). 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 11. Режим синхронизации Stream, количество повторов — один 

 

Если же мы хотим повторить петлю дважды (рис. 12), нам потребуется вдвое 

больше кадров, соответственно вес файла увеличится вдвое. Таким образом, 

повтор потоковых звуков не рекомендуется. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Рис. 12. Фильм занимает в два раза больше кадров 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 13. Добавление фоновой музыки 

Теперь рассмотрим пример, в котором используем тот же Loop-фрагмент для 

звукового сопровождения анимации (рис. 13). Для помещения звукового файла 

создадим слой sound. Обратите внимание: если мы добавим Loop-фрагмент, 

который превышает 34 кадра (длина анимационного ролика), и поставим режим 

синхронизации Event и режим повторов Loop, то мелодия будет накладываться 

сама на себя. Если же мы поставим параметры Start/Loop (как показано на рис. 13), 

то получим следующий озвученный фильм poletpticyisozvukom.swf. 

 

Добавление звука к кнопке 

Интерфейс становится более выразительным, когда нажатие на кнопки 

сопровождается не только визуальными, но и звуковыми эффектами. Рассмотрим, 

как можно добавить звуковые эффекты к кнопкам. 

Для начала обратимся к папкам с готовыми кнопками по команде Window => 

Common Libraries => Buttons (рис. 14). В результате появится панель, рис. 15 

Выберем, например, овальную кнопку и переместим ее на рабочий стол сцены. 

Затем откроем библиотеку проекта по команде Window => Library, выделим кнопку 

и, щелкнув по ней правой кнопкой, выберем режим редактирования — Edit (рис. 

16). 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 14. Доступ к библиотеке кнопок 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 15. Выбор кнопки из папки Oval buttons 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 16. Переход в режим редактирования кнопки 

 

В результате появится монтажная линейка кнопки (рис. 17). Создадим на 

этой монтажной линейке новый слой для звука и назовем его Sоund. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 17. Добавление нового слоя Sound 

 

Если нужно озвучить процесс нажатия кнопки, следует создать ключевой 

кадр во фрейме с меткой Down. Импортируем в библиотеку необходимый звук, а 

затем добавим его в ключевой кадр Down (рис. 18). 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 18. Добавление звука кнопке 

В панели Properties (рис. 19) выберем режим синхронизации Event (по 

событию) (количество повторов 1). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Рис. 19. Режим синхронизации для звука кнопки Использование Средств 

Редактирования Звука 

 

Программа Flash позволяет редактировать импортированный звук: задавать 

точки начала и конца воспроизведения, управлять его громкостью, задавать 

эффекты и т.д. 



Доступ к редактору осуществляется из панели Properties. Для 

редактирования звукового файла выберите кадр, содержащий звук, и щелкните на 

кнопке Edit в правой стороне панели Properties. В результате появится панель 

редактирования шаблона Edit Envelope (рис. 20). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 20. Окно редактирования шаблона Edit Envelope 

 

Как видно на рис. 20, часть речевого файла, в котором содержится начальная 

пауза (период с момента включения записи до первого произнесенного слова), 

расположена вне зоны воспроизведения. Достигается это путем перемещения 

указателей начала и конца звучания (рис. 21). 

 

 

 

 

 

 

 

 

 

 

 

 
 



 
 

Рис. 21. Указатели начала и конца звучания 

Для того чтобы исключить ненужные участки, достаточно переместить 

указатели начала и конца звучания (Time In Control и Time Out Control) так, чтобы 

в зону воспроизведения попала только речь диктора. 

Редактор позволяет также изменить уровень громкости для левого и правого 

каналов путем перемещения управляющих маркеров (Envelope handles) (рис. 22), 

которые позволяют установить вид огибающей, определяющей характер 

изменения громкости. 

В нашем примере (см. рис. 22) мы установили маркеры таким образом, чтобы 

имитировать перетекание звука из одного канала в другой. То есть в правом канале 

звук начинает воспроизводиться с максимальной громкостью и спадает до 

минимума, а в левом — наоборот. В результате получается эффект (peretekanie.swf) 

перетекания звука из одного канала в другой. 
 



 
Рис. 22. Эффект перетекания звука из одного канала в другой 

Можно создать и более сложные профили огибающей (рис. 23). 

Дополнительные маркеры (общим количеством до восьми) создаются простым 

щелчком на огибающей линии уровня звука. Чтобы удалить маркер, его следует 

перетащить за пределы окна. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 23. Добавляя маркеры, можно задавать сложный профиль огибающей 

Эффект, который мы создали в примере (см. рис. 22) вручную, путем 

перетаскивания маркеров, можно задать проще. Для этого следует обратиться к 

окошку Effect, которое расположено в верхней части панели Edit Envelope (рис. 24). 



Если выбрать в этом окошке режим Fade Right to Left (рис. 24), то огибающие 

примут тот же вид, что и на рис. 22. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 24. Эффект Fade Right to Left 

Если выбрать обратный эффект (Fade Left to Right), то получим 

расположение огибающих, показанное на рис. 25. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 25. Эффект Fade Left to Right 

 

С другими эффектами читатели легко разберутся сами. 



Сжатие Звуков Для Экспорта 

Звук, несомненно, украшает Flash-проект, однако вес файла при добавлении 

звука увеличивается и соответственно скорость доставки фильма из Web пада-ет. 

Flash позволяет настроить опции сжатия для отдельных звуков, то есть для 

различных типов звуков (музыка, короткие звуки, речь) подобрать разные 

алгоритмы сжатия. Также можно настроить опции компрессии для всех 

событийных и потоковых звуков одновременно. 

Применение Компрессии К Выбранным Звукам 

Flash позволяет применить опции компрессии к выбранным звукам для 

экспорта. 

Для установки экспортных свойств для отдельного звука щелкните правой 

кнопкой мыши на звуковом файле в окне библиотеки и выберите пункт Рroperties 

в контекстном меню. в результате появится панель Sound Properties (рис. 26). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 26. Панель Sound Properties 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 27. Опции сжатия 

Выберите одну из опций сжатия (рис. 27): Default, ADPCM, MP3, Raw или 

Speech. Опция сжатия Default использует при экспорте Flash-клипа стандартные 

параметры сжатия звука, заданные в диалоговом окне Publish Settings. При выборе 

сжатия Default все дополнительные экспортные настройки становятся недоступны. 

Опция сжатия ADPCM позволяет использовать алгоритм сжатия ADPCM 

(Adaptive Differential Pulse Code Modulation), производящий сжатие с 

фиксированной скоростью, при котором все данные сжимаются на одну и ту же 

величину. Использование ADPCM-компрессии целесообразно при экспорте 

коротких звуков типа щелчков кнопки. 

Опция сжатия MP3 позволяет экспортировать звуки с MP3-компрессией. 

MP3 (MPEG-1 Audio Layer-3) — эффективный алгоритм, уменьшающий коли-

чество избыточной информации, которая используется для описания цифрового 

звука, и учитывающий особенности восприятия звука. Известно, например, что 

человеку свойственна неравномерная чувствительность к восприятию звука на 

разных частотах. Целесообразно использовать формат MP3 при экспорте длин-ных 

звуковых фонограмм, таких как музыкальные композиции. При экспорте 

импортированного MP3-файла можно оставить те настройки, с которыми он был 

импортирован. 

Опция Raw экспортирует звуки без компрессии. 

Опцию Speech целесообразно выбрать для экспорта речи. В данном случае 

будет использован алгоритм компрессии, специально адаптированный для сжатия 

речи. 

Применение Компрессии Ко Всем Звукам 

На этапе экспорта проекта в Swf-файл, производимого по команде File => 

Export => Export Movie, после того, как вы определите имя сохраняемого фай-ла, 

появится панель вида, как на рис. 28. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 28. Панель Export Flash Player 

Для задания частоты и степени сжатия звука для всех потоковых звуков и 

звуков событий в клипе нажмите на кнопку Set напротив Audio Stream для 

редактирования потоковых звуков (см. рис. 28) или Audio Event для 

редактирования событийных звуков и выберите опции компрессии, частоты и 

качества в диалоговом окне Sound Settings (рис. 29). 
 
 
 
 
 
 
 
 
 
 
 
 

Рис. 29. Панель Sound Settings 

Общие Рекомендации По Экспорту Звука 

Не зацикливайте потоковые звуки. 

Корректируйте точки начала и окончания звуков, чтобы не сохранять 

тишину. 

Используйте один и тот же звук, применяя к нему различные эффекты, чтобы 

добиться иллюзии воспроизведения различных звуков. 

Используйте индивидуальный режим сжатия для разных звуковых файлов. 

Используйте Loop-фрагменты (Петли) для коротких звуков при создании фоновой 

музыки. 



Задание: 

Прикрепить звук к созданной ранее анимации. Добиться минимального 

размера файла. 
 

ЛАБОРАТОРНАЯ РАБОТА 8. БАЗОВЫЕ НАВЫКИ РАБОТЫ ВDEDUCTOR STUDIO 5.1 

 

Общие сведения 
Развитие и назначение Deductor 

 

Deductor – это аналитическая платформа, основа для создания законченных 

прикладных решений в области анализа данных. Реализованные в Deductor 

технологии позволяют на базе единой архитектуры пройти все этапы построения 

аналитической системы: от консолидации данных до построения моделей и 

визуализации полученных результатов. 

До появления аналитических платформ анализ данных осуществлялся в 

основном в статистических пакетах. Их использование требовало высокой 

квалификации пользователя. 

Большинство алгоритмов, реализованных в статистических пакетах, не 

позволяло эффективно обрабатывать большие объемы информации. Для 

автоматизации рутинных операций приходилось использовать встроенные языки 

программирования. 

В конце 80-х гг. произошел стремительный рост объемов информации, 

накапливаемый на машинных носителях и возросли потребности бизнеса по 

применению анализа данных. Ответом этому стало появление новых парадигм 

2. анализе: хранилища данных, машинное обучение, Data Mining, Knowlegde 

Discovery in Databases. Это позволило популяризировать анализ данных, вывести 

его на промышленную основу и решить огромное число бизнес-задач с большим 

экономическим эффектом. 

Венцом развития анализа данных стали специализированные программные 

системы – аналитические платформы, которые полностью автоматизировали все 

этапы анализа от консолидации данных до эксплуатации моделей и интерпретации 

результатов. 

Первая версия Deductor увидела свет в 2000 г. и с тех пор идет непрерывное 

развитие платформы. В 2007 г. выпущена 5-я по счету версия системы. Сегодня 

Deductor – это яркий представитель как настольной, так и корпоративной системы 

анализа данных последнего поколения. 

Общие сведения о Deductor 

Аналитическая платформа Deductor состоит из 5 частей: 

3. Warehouse – хранилище данных, консолидирующее информацию из 

разных источников; 

4. Studio – приложение, позволяющее пройти все этапы построения 

прикладного решения, рабочее место аналитика; 



5. Viewer – рабочее место конечного пользователя, одно из средств 

тиражирования знаний (т.е. когда построенные аналитиком модели используют 

пользователи, не владеющие технологиями анализа данных); 

6. Server – служба, обеспечивающая удаленную аналитическую обработку 

данных; 

7. Client – клиентдоступак Deductor Server. Обеспечивает доступ к серверу 

из сторонних приложений и управление его работой. 

Существует три типа варианта поставки платформы Deductor: 

 

 Enterprise; 
 Professional; 
 Academic. 

5. зависимости от типа поставки набор доступных компонентов может 

различаться. 
Версия Enterprise предназначена для корпоративного использования. В ней 

присутствуют: 

 СерверныекомпонентыDeductor Server иDeductor Client. 
 Интерфейсдоступак Deductor черезмеханизм OLE Automation. 
 Традиционное  хранилище  данныхDeductor  Warehouse  на  3-х  СУБД: 

= Виртуальное хранилище данных Deductor Virtual Warehouse. 
Версия Professional предназначена для небольших компаний и 

однопользовательской работы. В ней отсутствуют серверные хранилище данных 

можно создавать только на СУБД FireBird. Автоматизация выполнения сценариев 

обработки данных осуществляется только через пакетный режим. 

Версии Professional и Enterprise требуют установки драйверов Guardant для 

работы с лицензионным ключом. 

Версия Academic предназначена для образовательных и обучающих целей. 

Ее функционал аналогичен версии Professional за исключением: 

3. отсутствует пакетный запуск сценариев, т.е. работа в программе может 

вестись только в интерактивном режиме. 
4. отсутствует импорт из промышленных источников данных: 1С, СУБД, 

файлы MS Excel. 
 

Категории пользователей Deductor 

В процессе развертывания и использования аналитической платформы с 

ней взаимодействуют различные категории пользователей. Можно выделить 

четыре основные категории: 
 

5. аналитик; 
6. пользователь; 
7. администратор; 
8. программист. 

Функции аналитика: 

 создание в Deductor сценариев – последовательности шагов, которую 

необходимо провести для получения нужного результата. 
 построение, оценка и интерпретация моделей. 



 настройка панели отчетов для пользователей Deductor Viewer. 
 настройка сценария на поточную обработку новых данных. 

Функции пользователя: 

3. просмотр готовых отчетов в Deductor Viewer. 
Функции администратора: 



3. установка компонентов Deductor на рабочих местах и сервера ключей 

5. развертывание традиционного хранилища данных на сервере. 
6. контроль процедур регулярного пополнения хранилища данных. 
7. конфигурирование сервера Deductor Server. 
8. настройка пакетной и/или серверной обработки сценариев Deductor. 
9. оптимизация доступа к источникам данных, в том числе к хранилищу 

данных. 
Функции программиста: 

4) интеграция Deductor с источниками и приемниками данных. 
5)вызов Deductor из внешних программ различными способами, в том 

числе взаимодействие с Deductor Server. 
Такая работа как проектирование и наполнение хранилище данных, часто 

выполняется коллективно аналитиком, администратором и программистом. 

Аналитик проектирует семантический слой хранилища данных, то есть определяет, 

какие данные необходимо иметь в хранилище. Администратор создает хранилище 

данных и наполняет его данными. Программист при необходимости создает 

программные модули, выполняющие выгрузку информации из учетных систем в 

промежуточные источники (так называемые транспортные таблицы). 

 

Установка Deductor 

Установку Deductor рекомендуется проводить администратору системы, 

однако, при наличии прав администратора в Windows это может сделать и 

аналитик. Установка может быть произведена на компьютер с операционной 

системой MS Windows 2000 и выше. Системные требования к компьютеру 

изложены в справочной системе. 

Для установки Deductor Professional/Academic запустите файл инсталлятора 

и следуйте инструкциям по установке. На странице ВЫБОР КОМПО-НЕНТОВ 

программы установки предоставляется выбор, какой набор компонентов пакета 

Deductor необходимо установить на компьютер. В выпадающемсписке можно 

выбрать предопределенные конфигурации установки платформы, и программа 

установки сама предложит нужный набор компонентов. 

После установки программ серии Professional и Enterprise дополнительно 

потребуется настроить работу c электронным ключом защиты от копирования. 

Установку и подсоединение электронного ключа осуществляет администратор. 

Существуют два вида ключей – локальный и сетевой. Локальный ключ 

устанавливается на том же компьютере, что и Deductor, и работать с ним можно 

только с этой рабочей станции. Сетевой ключ устанавливается на сервере, и к нему 

могут подключаться несколько пользователей одновременно (количество 

пользователей ограничивается типом приобретаемой лицензии). 

При каждом запуске Deductor пытается найти доступный электронный ключ. 

В случае если ключ не найден, могут появиться следующие сообщения об ошибке: 

 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 

Задание: 

 

9) Установите Deductor Studio (конфигурация Рабочее место аналитика) и 

убедитесь, что он запускается. 
 

Вопросы для проверки: 

1. Из каких частей состоит Deductor? 
2. Какие варианты поставки Deductor существуют? 
3. Чем отличается версия Professional от Academic? 
4. Имеются ли ограничения по количеству обрабатываемых записей в 

версии Deductor Academic? 

5. Сколько категорий пользователей Deductor можно выделить? 

6. Перечислите функции аналитика. 

7. Кто обычно занимается проектированием и наполнением хранилища 

данных? 

8. Каким образом лицензируется Deductor? 

9. У Вас установлен Deductor. При запуске Deductor Studio появляется 

сообщение об ошибке Windows NT driver is required. Какова наиболее вероятная 

причина ошибки? 



 

10. Начало работы с системой 
 

Главное окно Deductor Studio 

 

После запуска главное окно Deductor Studio выглядит следующим образом. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

По умолчанию панель управления представлена одной вкладкой Сценарии. 

Кроме того, доступны еще 2 вкладки: Отчеты и Подключения. Сделать их 

видимыми можно следующими способами: 

В главное меню Вид/Отчеты и Вид/Подключения 
В кнопки и на панели инструментов. 

Можно производить drag&drop манипуляции с вкладками, меняя их 

расположение и порядок. 
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При нажатии правой кнопки мыши на любой вкладке появляется контекстное 

меню: 

 
 
 
 
 
 
 
 
 
 

 Скрыть – делает вкладку невидимой; 
 Переименовать – переименовывает название вкладки; 
 Закладки – переключается на выбранную закладку; 
 Верх/Низ – задает расположение названий вкладок: вверху либо внизу; 
 Помощь – открывает раздел справки. 

Справка по программе 

 

Справка по программе вызывается из главного окна системы следующими 

способами: 

 главное меню?/Справка, 
 клавиша <F1>, 

 кнопка на панели инструментов  
Помощь содержит подробное описание работы с Deductor Studio: системные 

требования, настройки узлов, способы осуществления действий с объектами 

системы. 
 

Понятие проекта 

В Deductor Studio ключевым понятием является Проект. Это файл с 

расширением*.ded, по структуре соответствующий стандартному xml-файлу. Он 

хранит в себе: 

11. последовательности обработки данных (сценарии); 
12. настроенные визуализаторы; 
13. переменные Проекта и служебную информацию. 

Пример фрагмента файла *.ded: 

<?xml version="1.0" encoding="UTF-8"?> 

<Document> 

<Version> 

<Comments>Deductor Studio 

Enterprise</Comments><CompanyName>BaseGroup 

Labs</CompanyName><FileDescription>Deductor Studio 

Enterprise</FileDescription><FileVersion>5.1.0.85</FileVersion><InternalName>Ded

uctor Studio 

Enterprise</InternalName><LegalCopyright>BaseGroup</LegalCopyright><LegalTra

demarks>BaseGroup</LegalTrademarks><OriginalFilename>DStudio.exe</OriginalFil

ename><ProductName>Deductor Studio 

Enterprise</ProductName><ProductVersion>5.1</ProductVersion></Version> 



<EnvironmentVariables> 

<Variables> 

<Count>1</Count> 

<L_0>SESSION=NUM_02</L_0> 

</Variables> 

 

Создать новый проект в Deductor Studio можно следующими способами: 

 

1. главное меню Файл/Создать; 
2. кнопка Создать новый проект на панели инструментов; 
3. клавиши <Ctrl>+<N>. 
4. Открыть существующий проект из Deductor Studio: 
5. главное меню Файл/Открыть; 
6. кнопка Открыть проект на панели инструментов; 
7. клавиши <Ctrl>+<O>. 

Открыть проект можно еще одним способом – в главном меню Файл/История 

найти имя проекта. 

Способ работает в том случае, если вы недавно открывали этот проект, и он 

сохранился в менеджере историй проектов. 
 

4. одной запущенной копии Deductor Studio можно открыть только один 

проект. 
Для сохранения проекта под текущим именем нужно выбрать главное меню 

Файл/Сохранить, нажать кнопку  или комбинацию <Ctrl>+<S>. 
 

Для сохранения текущего проекта под другим именем: главное меню 

Файл/Сохранить как… 

 

Мастера 

В Deductor Studio вся работа ведется с использованием 5 мастеров: 

 

5. Мастер импорта; 
6. Мастер экспорта; 
7. Мастер обработки; 
8. Мастер визуализации; 
9. Мастер подключений. 

С помощью мастеров импорта, экспорта и обработки формируется сценарий. 

Сценарий состоит из узлов. Мастер подключений предназначен для создания 

настроек подключений к различным источникам и приемникам данных. Мастер 

визуализации настраивает визуализаторы для конкретного узла. 

Визуализатором называется любое представление набора данных в каком-

либо виде: табличном, графическом, описательном. Примеры визуализаторов: 

таблица, дерево, гистограмма, диаграмма, OLAP-куб и т.д. 

Задание: 

 

6. Создайте новый проект и сохраните его под именем test.ded. 
7. Сделайте видимой вкладку Подключения. 
8. Поменяйте местами порядок вкладок Сценарии и Подключения. 



9. Найдите в помощи раздел Системные требования. 
 
 

Вопросы для проверки: 

1. Сколько вкладок на панели управления Deductor Studio? 
2. Что такое проект в Deductor Studio? 
3. Какое расширение имеет файл проекта? 
4. Как создать новый проект? 
5. Как сохранить текущий проект под другим именем? 
6. Сколько проектов можно одновременно открыть в Deductor Studio? 
7. Сколько мастеров имеется в Deductor Studio? 

 

8. Сценарии 
 
 

Понятие сценария и узла обработки 

9. Deductor Studio для аналитика основополагающим понятием является 

сценарий. Сценарий представляет собой последовательность операций с 

данными, представленную в виде иерархического дерева. В дереве каждая 

операция образует узел, заголовок которого содержит: имя источника данных, 

наименование применяемого метода обработки, используемые при этом поля и 

т.д. Кроме этого, слева от наименования узла стоит значок, соответствующий 

типу операции. 
 
 
 
 
 
 
 
 
 
 
 
 

Если узел имеет подчиненные узлы, то слева от его названия будет рас-

положен значок «+», щелчок по которому позволит развернуть узел, т.е. сде-лать 

видимыми все его подчиненные узлы, при этом значок «+» поменяется на «–». 

Щелчок по значку «–», наоборот, сворачивает все подчиненные узлы. помощью 

клавиш Ctrl+↑ и Ctrl+↓ можно перемещать узлы по дереву вверх-вниз в пределах 

подчинения родительскому узлу. 
Сценарий состоит из ветвей. Deductor не имеет собственных средств для 

ввода данных, поэтому сценарий всегда начинается с узла импорта из какого-либо 

источника. Любой вновь создаваемый узел импорта будет находиться на верхнем 

уровне (подчиненным главному узлу Сценарии). 

Создание нового узла импорта осуществляется с помощью Мастера импорта. 

Вызвать мастер можно следующими способами: 

4. кнопка  на панели инструментов закладки Сценарии; 
5. клавиша <F6>; 
6. контекстное меню Мастер импорта... 



При вызове Мастера импорта откроется окно первого шага мастера. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

В нем все источники данных сгруппированы по следующим пяти категориям: 

2. хранилища данных; 
3. базы данных; 
4. прямой доступ к файлам; 
5. механизм MS ADO; 
6. бизнес-приложения. 

Некоторые категории могут отсутствовать в списке. Причинами этого может 

быть следующее: 

2. Версия Deductor. Например, категории Базы данных, Механизмы MS 

ADO и Бизнес-приложения отсутствуют в версии Academic. 
3. В дереве подключений (вкладка Подключения) не зарегистрировано ни 

одного объекта из данной категории. Например, если не настроено ни одного 

подключения к хранилищу данных, то категория Хранилища данных будет 

отсутствовать. 
3. Отключена «видимость» объекта или категории объекта. 

Дальнейшие шаги мастера импорта будут зависеть от того, какой объект 

дерева категорий был выбран аналитиком. 

К любому узлу импорта можно добавить узел обработки или узел экспор-та, 

предварительно выделив узел импорта мышью. Новый узел будет добавлен как 

подчиненный к узлу импорта. 

Создание нового узла обработки осуществляется с помощью Мастера 

обработки. Вызвать мастер можно следующими способами: 

 кнопка  на панели инструментов закладки Сценарии; 
 клавиша <F7>; 



 
 контекстное меню Мастер обработки... 

При вызове Мастера обработки откроется окно первого шага мастера. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

В нем все обработчики сгруппированы по следующим четырем категориям: 

8. очистка данных; 
9. трансформация данных; 
10. Data Mining; 
5. прочее. 

Некоторые узлы могут отсутствовать в списке. Причинами этого может быть 

следующее: 

6. версия Deductor; 
7. отключена «видимость» объекта (или целой категории) объекта; 

8. узел «устарел» и в текущей версии Deductor его создание 

невозможно(допускается только его чтение и настройка). 
Создание нового узла экспорта осуществляется с помощью Мастера 

экспорта. Вызвать мастер можно следующими способами: 

7. кнопка  на панели инструментов закладки Сценарии; 
8. клавиша <F8>; 
9. контекстное меню Мастер экспорта... 

В нем все приемники данных сгруппированы по следующим 5 категориям: 

9. хранилища данных; 
10. базы данных; 
11. файлы; 
12. Web серверы; 
13. прочее. 



Причины отсутствия некоторых объектов или категорий Мастера экспор-та 

аналогичны тем, что перечислены при описании Мастера импорта. 

 

После узла экспорта невозможно добавить ни один узел. 

 

Базовые операции над узлами сценария 

Кроме команд вызова Мастеров, к каждому узлу применимы базовые 

операции. Операции над узлами и ветками сценария можно выполнять 

следующими способами: 

12. кнопки панели инструментов на закладке Сценарии; 
13. контекстное меню; 
14. мышь. 

Список доступных операций: 

10. Открытие узла – узел запускается на выполнение, причем выполняются 

все родительские узлы, а справа открываются визуализаторы, настроенные для 

данного узла. В интерактивном режиме для каждого узла должен быть настроен 

хотя бы один визуализатор, например, Таблица или Сведения. Операция 

вызывается: 
 двойной щелчок мыши на узле; 

11. клавиши <Ctrl>+<Enter>; 
12. контекстное меню Открыть. 

14. Настройка узла – вызывается Мастер импорта, Мастер обработки или 

Мастер экспорта, в зависимости от типа узла, для изменения параметров обработки, 

производимой в узле. 
Операция вызывается: 

15. кнопка ; 
16. клавиши <Alt>+<Enter>; 
17. контекстное меню Настроить…. 

16. Активация/деактивация узла – узел может быть либо активным, либо 

неактивным. Если узел неактивный, то, сделав его активным, выполнится 

сценарий для этого узла, но визуализаторы отображены не будут. Делая узел 

неактивным, закрываются все визуализаторы для него и для всех подчиненных 

узлов, а сам узел и подчиненные узлы превращаются в неактивные. Эта операция 

может быть использована для освобождения памяти. Операция 

активации/деактивации вызывается: 
17. клавиши <Shift>+<Enter>; 
18. контекстное меню Активный…. 
18. Перечитать данные узла – все узлы до корневого включительно будут 

закрыты, а затем выполнена ветка сценария от корневого до текущего узла. 
Операция вызывается: 

10. контекстное меню Перечитать данные…. 



> Вырезать узел – удаляет текущий узел из сценария обработки. Все его 

потомки при этом перемещаются на один уровень вверх и начинают подчиняться 

родителю удаленного узла. 
Операция вызывается: 

> кнопка ; 
> контекстное меню Вырезать узел. 

3. Вставить узел – вставляет перед текущим узлом сценария новый узел и 

вызывает для него Мастер обработки. Вставить узел перед узлом импорта 

данных нельзя. Операция вызывается: 

- кнопка ; 
- контекстное меню Вставить узел. 

После вставки нового узла или удаления существующего узлы-потомки 

могут стать неработоспособными, в зависимости от обработки, выполняемой 

новым узлом. 

8. Копировать ветвь – копирует ветвь сценария, начиная с текущего узлавключая 

все его потомки. Операция вызывается: 
- кнопка ; 
- контекстное меню Копировать ветвь; 

- при помощи механизма drag&drop – выделив узел, и, удерживая нажатой 

клавишу <Ctrl>, указать курсором мыши на новый узел, который должен стать 

родителем старого. При этом переносимая ветка целиком скопируется в новое 

место. 
9. Удалить ветвь – удаляет узел сценария и все его подузлы. Удаленная 

ветвь восстановлению не подлежит, поэтому к данной операции необходимо 

подходить с осторожностью. Операция вызывается: 

- кнопка ; 
- клавиши <Ctrl>+<Del>; 
- контекстное меню Удалить ветвь. 

10. Перенос ветви переносит ветку сценария к новому узлу. Операция 

производится аналогично копированию ветви с помощью drag&drop без 

удерживания клавиши <Ctrl>. 
11. Переименовать – позволяет изменить метку текущего узла. Операция 

вызывается: 

- клавиша <F2>; 
- контекстное меню Переименовать... 
12. Сведения – открывает диалоговое окно Сведения для текущего узла. В 

нем редактируется имя, метка и описание к узлу. Операция вызывается: 
- контекстное меню Сведения...; 
- открыв скрытую панель узла с помощью кнопки  и нажать там 

одну из кнопок: Имя, Метка или Описание. 
Имя узла может быть задано только латинскими символами, тогда как метка 

– любыми. Кроме того, имя узла должно быть уникально в пределах од-ного 

сценария. Как правило, необходимости в переименовании имен узлов обычно не 

возникает. 



13. Статус пакетной обработки – устанавливает статус пакетной обработки 

для узла. 
14. Добавить в Избранное – текущий узел добавляется в список избранных 

узлов. 
15. Сохранение ветви – вызывается стандартный диалог «Сохранение», в 

котором можно указать путь и имя файла для сохранения ветви сценария, 

начинающейся с текущего узла. Операция вызывается: 
- контекстное меню Сохранить ветвь. 

16. Загрузка ветви – вызывает стандартный диалог «Открытие файла», в 

котором можно указать путь и имя файла, хранящего ветвь сценария. 

Загруженная ветвь сценария станет потомком текущего узла. Ветвь, 

начинающаяся с узла импорта данных, будет добавлена в проект как новая 

корневая ветвь. Операция вызывается: 
- контекстное меню Загрузить ветвь. 

 

По умолчанию ветвь сценария имеет расширение *.deb. 

Импорт из текстовых файлов с разделителями 

Структурированный текстовый файл с разделителями – один из самых 

распространенных форматов хранения данных. Такой файл представляет собой 

обычный текстовый файл, столбцы данных в котором разделены однотипными 

символами-разделителями, например символами табуляции, пробела, точки с 

запятой и т.д. 

Процесс импорта данных из текстового с разделителями файла в Мастере 

импорта (категория «Прямой доступ к файлам») содержит следующие шаги: 

- указание имени файла; 
- настройка параметров импорта; 
- настройка импортируемых полей; 
- запуск процесса импорта; 
- выбор способа визуализации; 
- задание сведений об узле. 

На шаге «Указание имени файла», нажав кнопку , необходимо выбрать имя 

текстового файла (расширения *.txt, *.csv), из которого следует выполнить импорт 

данных. После этого в поле «Имя файла» окна Мастера импорта появится имя 

выбранного файла и путь. Допускается вручную ввести путь к файлу в строке поля 

Имя файла. 

Имеется возможность использовать как абсолютные, так и относительные 

пути для файлов. Они указываются относительно текущей директории Deductor. 

При открытии Deductor текущей директорией является директория файла проекта. 

Поэтому, если файл проекта и текстовые файлы располагаются в одной папке, то 

использование относительных путей в Мастере импорта поз-волит не 

перенастраивать узлы импорта при изменении расположения папки на жестком 

диске. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

На шаге «Настройка параметров импорта» нужно настроить параметры 

импорта данных из текстового файла, так как форматов структурированных 

текстовых файлов существует несколько. 

Доступные настройки: 

- Начать импорт со строки – номер строки, начиная с которой будет 

осуществляться импорт данных из файла. 

- Первая строка является заголовком – установка флажка означает, что 

узел будет импортировать данные с учетом того, что все записи первой строки 

являются заголовками столбцов. 
- Символом-разделителем является – необходимо указать, что именно 

является разделителем в импортируемом файле: символ табуляции, пробел, 

точка, точка с запятой, запятая и т.д. 
Когда разделителем является символ, не указанный среди выше 

приведенных, то необходимо выставить данный параметр на значение Другой и в 

активизированном окне задать вручную символ-разделитель. 

- Считать последовательные разделители одним – в случае последовательно 

идущих символов-разделителей они будут восприниматься за один. Такое бывает, 

например, когда символом-разделителем выступают несколько пробелов. 

- Ограничитель строк – при задании данного параметра необходимо указать, 

какой именно ограничитель строкового значения нужно использовать при импорте 

данных из текстового файла. Обычно таким ограничителем является символ 

двойной кавычки". 

- Разделитель дробной и целой части числа – при задании данного параметра 

необходимо указать символ, разделяющий дробную и целую части в числовых 

значениях, содержащихся в файле. 

- Разделитель компонентов даты – указывается символ, разделяющий 

компоненты даты в соответствующих значениях, содержащихся в файле. 
- Разделитель компонентов времени – указывается символ, разделяющий 

компоненты времени в соответствующих значениях, содержащихся в файле. 
- Формат даты – указывается формат даты, используемый в 

импортируемом файле. 
 

- Формат времени – указывается формат времени, используемый в 

импортируемом файле. 



 

В качестве разделителей по умолчанию всегда предлагаются системные 

настройки операционной системы. Поэтому при импорте необходимо обращать 

внимание на их соответствие формату в импортируемом текстовом файле. 
На шаге «Настройка параметров столбцов» нужно настроить следующие 

параметры столбцов импортируемых данных, указав соответствующие значения в 

полях: 

Имя столбца – указывается имя, которое будет служить идентификатором 

столбца в последующих узлах. По умолчанию предлагается заголовок столбца из 

текстового файла, если на предыдущем шаге был установлен флажок Первая 

строка является заголовком. В противном случае будут предложены имена типа 

COL1, COL2 и т.д. Можно ввести любые имена, которые семантически отражают 

содержимое столбца, однако допускаются только латинские символы, и имя 

столбца должно быть уникальным в пределах всех столбцов импортируемого 

файла. 

Метка столбца – название, под которым данный столбец будет виден в 

визуализаторах. Допускаются любые символы, уникальность имен необязательна. 

Тип данных – указывается тип данных, содержащихся в столбце. Тип выбирается 

из списка, открываемого щелчком по кнопке в правой части поля: 

 
 
 
 
 
 
 
 
 
 

Узел импорта всегда пытается автоматически распознать тип данных по 

первой строке файла и (если имеются заголовки, то по второй строке). Такой 



алгоритм срабатывает не всегда. К примеру, пусть в файле есть столбец Число 

иждивенцев, и в нем данные идут в следующем порядке: 

 
 
 
 
 
 
 

 

Для данного поля автоматически определиться тип – вещественный, но в 

реальности он строковый. 

Вид данных – характер данных, содержащихся в столбце: 

 
 
 
 
 
 
 
 

Непрерывными могут быть только числовые данные. Дискретный харак-тер 

носят, как правило, строковые данные, но не всегда. Дискретными могут быть 

назначены в зависимости от контекста решаемой задачи данные целого типа, реже 

– вещественного. Вид данных столбца влияет на: 

- алгоритм расчета статистики по столбцу; 
- работу аналитических алгоритмов. 

Назначение – определяет порядок использования поля набора данных, 

полученного в результате импорта столбца (поля), при дальнейшей обработке 

импортированных данных: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Изменить назначение группы столбцов одной операцией можно следующим 

образом: 

- удерживая клавишу <Shift>, выделить мышкой или клавишами Ctrl+↓, 

Ctrl+↑ первый и последний столбцы группы столбцов и изменить их назначение; 
- удерживая клавишу <Ctrl>, выделить мышкой только нужные столбцы и 

изменить их назначение. 
Пояснение. Установка назначения столбца набора данных при импорте не 

является обязательным действием (по умолчанию при импорте установлено 

назначение «информационное»). Однако это может снизить объем рутинных 

действий при последующем конструировании сценария. Например, при 

построении моделей (группа узлов обработки Data Mining) по умолчанию 

выходным полем, как правило, предлагается последнее поле, и, если это не так, 

придется каждый раз переопределять назначения полей в каждом новом узле. 

На шаге «Запуск процесса импорта» стартует сам процесс импорта данных с 

ранее настроенными параметрами. Ход процесса импорта отображается спомощью 

индикатора. Если процесс импорта остановился, это сигнализирует о возможных 

ошибок при чтении данных. В этом случае появляется окно с сообщением об 

ошибке. 

В случае возникновения ошибок несоответствия типов процесс импорта 

будет продолжен, но после его окончания будет отображен журнал регистрации 

ошибок с информацией о месте и причине их появления: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Для управления процессом импорта предусмотрены следующие кнопки: 

- Пуск – запускает процесс в первый раз или возобновляет после паузы. 
- Пауза – временно приостанавливает импорт. 
- Стоп – останавливает процесс без возможности его продолжения. 

 

На оставшихся двух шагах Мастера импорта будет предложено выбрать 

визуализатор набора данных (по умолчанию предлагается Таблица) и задать 

сведения об узле. 
 



Узел Настройка набора данных 

 

Обработчик Настройка набора данных позволяет: 

- изменить имя, метку, тип, вид и назначение полей текущего набора данных; 

- изменить порядок следования столбцов в наборе данных; 
- скрыть столбцы набора данных; 
- задать опцию кэширования выходного набора. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Изменение имени или метки поля удобно в тех случаях, когда имена 

столбцов могут измениться в источнике данных или при перенастройке узлов 

верхних уровней. В этом случае в узле Настройка набора данных имя исходно-го 

столбца заменяется другим, на которое и настраиваются все дочерние узлы. После 

такой операции изменение имен полей на верхних уровнях не потребует 

перенастройки всех дочерних узлов в дереве сценариев. 

Тип, вид и назначение можно изменить у нескольких столбцов одной 

операцией. Для этого достаточно их выделить, удерживая нажатой клавишу <Ctrl> 

или <Shift>. Если параметры столбца были изменены, цвет иконки столбца 

меняется на красный. Для установки первоначальных параметров столбцов 

необходимо выделить столбец или список столбцов и нажать на кнопку Сброс 

параметров. 

Чтобы скрыть столбец из набора данных, нужно задать ему назначение 

Неиспользуемое. 

Изменить порядок следования столбцов в наборе данных можно при по- 

мощи клавиш . 

Кэширование – это загрузка часто используемой информации в оперативную 

память для быстрого доступа к ней, минуя многократные считывания с жесткого 

диска. Кэширование может заметно повысить скорость работы сценария в ряде 



случаев (использование кэширования не входит в базовые навыки работы с 

Deductor). 
 

Экспорт в текстовый файл 

Выполняется при помощи Мастера экспорта. Процесс импорта данных из 

текстового с разделителями файла в Мастере импорта (категория «Прямой доступ 

к файлам») содержит следующие шаги: 

- задание параметров экспорта; 
- выбор экспортируемых полей; 
- настройка импортируемых полей; 
- запуск процесса экспорта; 
- выбор способа визуализации; 
- задание сведений об узле. 

На шаге «Задание параметров экспорта» настраиваются параметры экспорта 

данных из текстового файла аналогично тем, что задавались в Мастере импорта. 

Экспортировать допускается не все поля, а только те, у которых установлен 

флажок на шаге «Выбор экспортируемых полей»: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Здесь же задается имя файла экспорта. По умолчанию предлагается имя 

файла export.txt. Как и в случае с импортом, допускается использовать 

относительные пути. 



Флажок Открыть после создания откроет текстовый файл программой 

просмотрщиком. Установка флага Отправить на E-mail позволяет отправить файл 

на почтовый адрес в виде вложенного в письмо файла (доступно только в версии 

Enterprise). 

Вкладка запуска процесса экспорта аналогична той, что присутствовала в 

Мастере импорта. 

Если файл с таким именем уже существует, возникнет окно с 

подтверждением о перезаписывании этого файла. На шаге выбора способа 

визуализа-ции будет доступен только один визуализатор Прочее. Задание сведений 

об уз-ле завершит работу мастера экспорта. 

Узел «!» 

При открытии сценария некоторые узлы могут иметь значок , а при 

попытке выполнить ветвь узла появится, например, следующее сообщение: 

 
 
 
 
 
 
 
 
 
 

Значок  говорит о том, что выполнить данный узел невозможно. 

Причинами этого могут быть. 

- Узел не поддерживается в текущей поставке Deductor. Например, узлы 

импорта из 1С не выполняются в Deductor Academic. 
- Сценарий создан в более поздней версии (сборке) Deductor, а открыт в 

более ранней, и функционал такого узла не существовал в ранних версиях. Номер 

сборки можно проверить, открыв меню?/ О программе. 
Задание: 

1. Создайте новый проект и сохраните его под именем test2.ded. 
2. Создайте и сохраните в любом текстовом редакторе файл следующего 

вида: 
a,1,4.5,b,c,26/04/2007,d 

a1,0,5,b1,c1,,d1 

Импортируйте его в Deductor, корректно настроив параметры импорта. 

Используйте относительный путь для файла. Метку узла переименуйте в «Пример 

импорта файла». В комментарии к узлу впишите: «Текстовый файл с 

разделителями-запятыми». 

3. Добавьте к узлу узел Настройка набора данных и задайте следующие 

метки к столбцам: 
Поле1, Поле2, Поле3 и т.д. 

4. Экспортируйте набор данных в текстовый файл с настройками, 

предлагаемыми по умолчанию. 
5. Импортируйте только что экспортированный файл в Deductor. 



6. Присоедините к новому узлу импорта (путем копирования) 

предыдущую ветвь, начиная с узла Настройка набора данных. 
7. Между экспортом и настройкой набора данных вставьте еще один узел 

настройки, в котором измените тип столбца Поле2 на логический. 
8. Удалите только что вставленный узел. 
9. Сохраните проект. 

 
 

Вопросы для проверки: 

 

1. Сколько вкладок на панели управления Deductor Studio? 
2. Что такое «проект» в Deductor Studio? 
3. Какое расширение имеет файл проекта? 
4. Как создать новый проект? 
5. Как сохранить текущий проект под другим именем? 
6. Сколько проектов можно одновременно открыть в Deductor Studio? 
7. Сколько мастеров имеется в Deductor Studio? 

8. Вы импортировали текстовый файл, создав узел импорта. После чего 

обнаружили, что неправильно задали параметры импорта. Как легче всего 

исправить ошибку? 

9. Как скопировать ветвь сценария при помощи механизма drag&drop? 
10. Какие шаги мастера импорта нужно пройти для импорта текстового 

файла? 
11. Что позволяет сделать обработчик Настройка набора данных? 

12. Как происходит автоматическое определение типа столбца при 

импорте? 

13. Что означает пиктограмма «!» напротив узла сценария? 
  



ЛАБОРАТОРНАЯ РАБОТА 9. БАЗОВЫЕ ВИЗУАЛИЗАТОРЫ 

 

К каждому узлу сценария, который содержит структурированный набор 

данных, всегда предлагается несколько визуализаторов. Мастер визуализации в 

интерактивном пошаговом режиме позволяет выбрать и настроить наиболее 

удобный способ представления данных. В зависимости от выбранного способа 

будут настраиваться различные параметры, а Мастер, соответственно, будет 

содержать различное число шагов. Первый шаг Мастера визуализации будет 

одинаков для всех видов, поскольку на нем и производится выбор визуализатора. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Вызов Мастера визуализации: 

- кнопка  на панели инструментов закладки Сценарии; 
- клавиша <F5>; 
- контекстное меню Мастер визуализации… 
Мастер визуализации запускается для выделенного узла сценария. Кроме 

того, Мастер визуализации всегда является продолжением Мастера обработки, т.е. 

активизируется при создании (настройке) узла. 

Желаемые способы отображения следует пометить флажками. 

Одновременно может быть выбрано несколько визуализаторов, при этом каждый 

из них будет открыт в отдельном окне. 

Замечание: если на 1-м шаге Мастера визуализации одновременно выбрано 

несколько способов отображения данных, то все соответствующие шаги будут 

последовательно включены в общую процедуру настройки. Например, если 

выбраны таблица и диаграмма, то в Мастер визуализации будут последовательно 

включены отдельные шаги для настройки таблицы и диаграммы. 
 



Базовыми визуализаторами в Deductor являются следующие: 

- Таблица; 
- Статистика; 
- Сведения. 
Визуализатор Таблица 

 

В таблице каждое поле набора данных размещается в отдельном столбце. 

Столбцы озаглавлены метками полей, а если метка не была задана, то именами 

полей. Ширину и порядок столбцов можно менять при помощи мыши. 

В таблице можно настроить объединение заголовков столбцов. Например, 

есть два заголовка Продажи Сумма и Продажи Количество. Если переименовать 

(например, с помощью обработчика Настройка набора данных) метку первого 

столбца в Продажи|Сумма, а второй – в Продажи|Количество, то получим 

объединение заголовка в шапке таблицы: 

 
 
 
 
 

Символ «|» подсказывает визуализатору место в слове, где заканчивается 

общее название у двух заголовков. 



Последовательное нажатие левой кнопкой мыши по заголовку активирует 

сортировку по данному столбцу в следующем порядке: сортировка по возрастанию 

 – сортировка по убыванию  – исходное состояние. Столбцы логического типа 

показываются в виде флажков. 

В верхней части окна таблицы представлена панель инструментов, кнопки 

которой открываю доступ к следующим функциям. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Однажды настроенный вид таблицы (к примеру, с различными фильтрами, 

форматами и видимостью столбцов и т.п.) можно сохранить, чтобы впоследствии 

быстро вернуться к нему. Для этого в раскрывающемся по кнопке  списке 

нужно выбрать пункт Сохранить конфигурацию… и далее ввести ее название. 

Загрузить новую конфигурацию, можно, выбрав ее из списка конфигураций. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

При вызове настройки полей появляется соответствующее диалоговое окно. 

В нем можно скрыть или сделать видимыми различные поля таблицы, определить 

способ выравнивания содержимого, ширину поля, а также задать формат 

отображения числовых данных и дат. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Кнопка  переключает способ отображения набора данных, который 

может быть не только табличным, но и в виде формы. Это удобно, когда набор 

данных содержит большое количество столбцов. 

Кнопка  открывает окно настройки условий фильтрации на набор данных. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

При включенном фильтре цвет кнопки меняется на , а цвет заголовков 

столбцов, которые участвуют в фильтре, изменяется на красный: 

 
 
 
 
 
 
 
 
 
 

Кнопка  открывает визуализатор Статистика, но не в отдельном вклад-ке, 

а в нижней части визуализатора Таблица. 
 

Визуализатор Статистика 

 

Статистика служит для отображения основных статистических 

характеристик набора данных конкретного узла. 

Статистические характеристики отображаются в таблице по каждому по-лю 

выборки. В верхней части окна статистики отображается общее количество 

записей в наборе данных. Панель инструментов окна статистики позволяет 

управлять отображением статистических характеристик (среднее, 

минимум,максимум и т.п.) с помощью группы кнопок . 
 
 
 
 
 
 

Для полей дискретного типа, кроме прочих, всегда рассчитываются 

следующие статистические показатели: 



- количество уникальных значений, 
- количество пустых значений. 
Просмотреть список уникальных значений можно следующими 

способами: 

- двойной щелчок по ячейке Количество уникальных значений, 
- кнопка . 
Визуализатор Сведения 

Визуализатор Сведения позволяет просмотреть все параметры, с 

которы-ми был выполнен тот или иной процесс преобразования данных, в 

результате которого была сформирована новая выборка: импорт, обработка 

одним из методов или экспорт. Такими параметрами являются время и 

длительность выполняемого процесса, условия остановки, наличие 

первичного ключа, ограничители столбцов, разделители целой и дробной 

частей чисел, элементов даты и т.д. 

Предусмотрено два вида представления описания: в виде дерева и 

текстовый. По умолчанию устанавливается вид дерева. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Визуализатор в основном предназначен для оперативного анализа 

текущих настроек узлов и для поиска возможных ошибок. 

Визуализатор Сведения является единственным доступным для узлов 

экспорта. 

Задание: 

1. Откройте проект Deductor, созданный на прошлом занятии. 

Настройте следующие визуализаторы к любому узлу импорта: Таблица, 

Статистика. Перейдите в режим формы и обратно. Имеются ли пропуски в 

записях? 

2. В визуализаторе Таблица настройте, чтобы при отображении к 

значениям вПоле3 добавлялось слово «кг.». Сохраните конфигурацию 

визуализатора под названием «К1». 



3. Сделайте первые три столбца невидимыми. Сохраните 

конфигурацию визуализатора под названием «К2». 
4. Вернитесь к конфигурации К1. 

5. В визуализаторе Таблица установите фильтр «Поле6 = не пустой». 

Удалите фильтр. 
 

Вопросы для проверки: 

 

1. Какие характеристики набора данных показывает визуализатор 

Статистика? 

2. Что означает красный заголовок столбца в визуализаторе Таблица? 
3. Как обнаружить, имеются ли в поле набора данных пропущенные 

значения? 

4. Для чего предназначен визуализатор Сведения? 
5. Как скрыть столбец в визуализаторе Таблица? 
6. К существующему в сценарии узлу импорта необходимо добавить еще 

один визуализатор. Что предпринять? 
 

4. Учебно-методическое и информационное обеспечение дисциплины 

 

4.1. Перечень основной  и дополнительной литературы, необходимой для освоения 

дисциплины 

4.1.1. Перечень основной литературы: 

1. Богданова, С.В. Информационные технологии : учебное пособие для студентов 

высших учебных заведений / С.В. Богданова, А.Н. Ермакова ; ФГБОУ ВПО 

Ставропольский государственный аграрный университет, Министерство сельского 

хозяйства РФ. - Ставрополь : Сервисшкола, 2014. - 211 с. : ил. - Библиогр. в кн. ; То же 

[Электронный ресурс]. - URL: http://biblioclub.ru/index.php?page=book&id=277476 

2. Борисова И.В. Цифровые методы обработки информации [Электронный ресурс]: 

учебное пособие/ Борисова И.В.— Электрон. текстовые данные.— Новосибирск: 

Новосибирский государственный технический университет, 2014.— 139 c.— Режим 

доступа: http://www.iprbookshop.ru/45061.— ЭБС «IPRbooks», по паролю 

3. Бельчик, Т.А. Основы математической обработки информации с помощью SPSS : 

учебное пособие / Т.А. Бельчик. - Кемерово : Кемеровский государственный университет, 

2013. - 232 с. - ISBN 978-5-8353-1265-8 ; То же [Электронный ресурс]. - URL: 

http://biblioclub.ru/index.php?page=book&id=232214 

 

4.1.2. Перечень дополнительной литературы: 

1. Исаев, Г. Н. Информационные технологии : учеб. пособие / Г.Н. Исаев. - М. : 

Омега-Л, 2012. - 464 с. : ил. - (Высшее техническое образование). - Библиогр.: с. 462-463. - 

ISBN 978-5-370-02165-7 

2. Кузнецов, С.М. Информационные технологии : учебное пособие / С.М. Кузнецов. 

- Новосибирск : НГТУ, 2011. - 144 с. - ISBN 978-5-7782-1685-3 ; То же [Электронный 

ресурс]. - URL: http://biblioclub.ru/index.php?page=book&id=228789 

http://biblioclub.ru/index.php?page=book&id=277476
http://biblioclub.ru/index.php?page=book&id=232214
http://biblioclub.ru/index.php?page=book&id=228789


3. Коноплева, И.А. Информационные технологии : учебное пособие / 

И.А. Коноплева, О.А. Хохлова, А.В. Денисов ; под ред. И.А. Коноплева. - 2-е изд., перераб. 

и доп. - М. : Проспект, 2014. - 328 с. - Библиогр. в кн. - ISBN 978-5-392-12385-8 ; То же 

[Электронный ресурс]. - URL: http://biblioclub.ru/index.php?page=book&id=251652 

4.2. Перечень учебно-методического обеспечения самостоятельной работы 

обучающихся по дисциплине:  

1. Методические указания по выполнению лабораторных работ по дисциплине 

«Технология обработки информации».  

2. Методические рекомендации для студентов по организации самостоятельной 

работы по дисциплине «Технология обработки информации». 

 

4.3. Перечень ресурсов информационно-телекоммуникационной сети «Интернет», 

необходимых для освоения дисциплины:  

1. http://www.intuit.ru – сайт дистанционного образования в области 

информационных технологий 

2. http://e.lanbook.com – ЭБС издательства «Лань». 

3. http://www.biblioclub.ru – университетская библиотека онлайн. 

4. http://window.edu.ru – образовательные ресурсы ведущих вузов 

5. http://trpo.is-isea.ru/ 

6. http://www.iprbookshop.ru 

7. Интернет-ресурсы: Все для учебы StudFiles - - http://www.studfiles.ru  

8. Интернет-университет информационных технологий. - - www.intuit.ru 

9. Научно-информационный портал - - http://sci-lib.com 
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